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User Registration Request

Thank you for purchasing YOKOGAWA products.

Please register to the following Customer Portal Member Site.

You can use various services such as confirmation of purchased product information,
download of related materials, and newsletter.

https://myportal.yokogawa.com/
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Introduction

Thank you for purchasing the Dagstation DX2000 (DX).This
manual describes the basic operating procedures and installation
and wiring procedures of the DX2000. To ensure correct use,
please read this manual and the manuals below thoroughly before
beginning operation.

For the product specifications, see the general specifications.

Paper Manual

Manual Title Manual No."
DX2000 Operation Guide IM 04L42B01-02E
This manual.

Control of Pollution Caused by the Product IM 04L41B01-91C
Gives a description of pollution control.

About the Usage of Open Source Software IM 04L41B01-81Z1

DAQSTANDARD

Download the DAQSTANDARD (Application software) from the
following URL.

URL: https://www.yokogawa.com/ns/dxadv/download/

Electronic Manuals

User's manuals for the DX are available on the following web site:
http://www.yokogawa.com/ns/dxadv/im/

You need Adobe Reader 7.0 or later (but the latest version is
recommended) installed on the computer in order to open and read
the manuals.

Manual Title Manual No."

DX2000 Operation Guide IM 04L42B01-02E
This is the electronic version of the paper manual.

DX2000 User’s Manual IM 04L42B01-01E
Describes how to use the DX2000. The communication and
network functions, custom display functions, and some of the
options are excluded.

DX1000/DX1000N/DX2000
Multi Batch (/BT2) User’s Manual
Describes how to use the multi batch function (/BT2 option).

IM 04L41B01-03E

DX1000/DX1000N/DX2000 Custom IM 04L41B01-04E
Display User’s Manual
Describes how to use the custom display function.

DX1000/DX1000N/DX2000 Advanced IM 04L41B01-05EN
Security Function (/AS1) User’s Manual

Describes how to use the advanced security function

(/AS1 option).

DX1000/DX1000N/DX2000

Communication Interface User’s Manual
Describes how to use the communication functions using the
Ethernet and serial interfaces.

IM 04L41B01-17E

DX1000/DX1000N/DX2000
PLC Communication Protocol

IM 04L41B01-18E

Communication Interface User’s Manual
Describes how to use communication functions through the
PLC communication protocol interface.

DX1000/DX1000N/DX2000
PROFIBUS-DP (/CP1) Communication
Interface User’s Manual
Describes how to use communication functions through the
PROFIBUS-DP interface (/CP1 option).

IM 04L41B01-19E

The electronic manual (CD, part no. B8706ZZ) is available for
purchase. Please contact your nearest YOKOGAWA dealer for
details.

DAQSTANDARD Manuals

Manual Title Manual No."

DAQSTANDARD Viewer User’s Manual IM 04L41B01-63EN

DAQSTANDARD Hardware Configurator ~ IM 04L41B01-64EN
User’s Manual

DAQSTANDARD DX-P Hardware
Configurator User’s Manual

IM 04L41B01-65EN

Installing DAQSTANDARD IM 04L41B01-66EN

General Specifications (GS)

General Specifications Name General Specifications No.

Dagstation DXAdvanced GS 04L42B01-01E
DX2000

* The last characters, "EN" for example, of the manual number
and general specifications number indicates the language in
which the manual is written.

Notes

» The contents of this manual are subject to change without
prior notice as a result of continuing improvements to the
instrument’s performance and functions.

» Every effort has been made in the preparation of this manual
to ensure the accuracy of its contents. However, should you
have any questions or find any errors, please contact your
nearest YOKOGAWA dealer.

»  Copying or reproducing all or any part of the contents of this
manual without YOKOGAWA's permission is strictly prohibited.

* This manual is part of this product. Keep this manual on safe
place for future reference.

* The TCP/IP software of this product and the document
concerning the TCP/IP software have been developed/
created by YOKOGAWA based on the BSD Networking
Software, Release 1 that has been licensed from the Regents
of the University of California

Authorised Representative in the EEA and the

Importer into the EU/EEA Market
The Authorised Representative for this product in the EEA and the
importer for this product into the EU/EEA market via Yokogawa sale
channel is:

Yokogawa Europe B.V.

Euroweg 2, 3825 HD Amersfoort, The Netherlands

Importer for This Product into the Great Britain

Market
In relation to UKCA marking, the importer for this product into the
Great Britain market via the YOKOGAWA sales channel is :
Yokogawa United Kingdom Limited
Stuart Road Manor Park Runcorn, WA7 1TR, United Kingdom

QR Code

The product has a QR Code pasted for efficient plant maintenance
work and asset information management.

It enables confirming the specifications of purchased products and
user’s manuals.

For more details, please refer to the following URL.
https://lwww.yokogawa.com/gr-code

QR Code is a registered trademark of DENSO WAVE
INCORPORATED.

14th Edition: August 2023 (YK)
All Rights Reserved, Copyright © 2005, Yokogawa Electric Corporation
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Trademarks

« DAQSTATION, Dagstation, and DXAdvanced are registered
trademarks of Yokogawa Electric Corporation.

» Microsoft and Windows are registered trademarks or trademarks
of Microsoft Corporation in the United States and/or other
countries.

» Adobe and Acrobat are registered trademarks or trademarks of
Adobe Systems Incorporated.

« Kerberos is a trademark of the Massachusetts Institute of
Technology (MIT).

« Company and product names that appear in this manual are
registered trademarks or trademarks of their respective holders.

» The company and product names used in this manual are not
accompanied by the registered trademark or trademark symbols
(®and ™).

Revisions

1st Edition: December 2005 2nd Edition: October 2006
3rd Edition: April 2007 4th Edition: December 2007
5th Edition: November 2008 6th Edition: March 2010

7th Edition: December 2010 8th Edition  March 2016

9th Edition: October 2016 10th Edition: June 2018
11th Edition: May 2019 12th Edition: June 2020
13th Edition: October 2022 14th Edition: August 2023

Safety Precautions

+ This instrument conforms to |IEC safety class | (provided with
terminal for protective grounding), Overvoltage Category Il or |,
Pollutuin Degree 2, and Measurement Category Il (CAT II).

» This instrument is an EN 61326-1 (EMC standard) class A
instrument (for use in commercial, industrial, or business
environments). The influence rate (judgment condition A) in the
immunity test environment is within 10 % of the range or +10
mV (50V range only, +20 % of the range).

* The general safety precautions described here must be
observed during all phases of operation. If the DX is used in a
manner not described in this manual, the DX safety features may
be impaired. Yokogawa Electric Corporation assumes no liability
for the customer’s failure to comply with these requirements.

» The DX is designed for indoor use.

« Safety and EMC Standards

CSA: CAN/CSA-C22.2 No. 61010-1,

CAN/CSA-C22.2 No. 61010-2-030
Overvoltage Category Il or I"!, Pollution Degree 22,
Measurement Category 11
UL: UL61010-1, UL 61010-2-030 (CSA NRTL/C)
Overvoltage Category Il or I"!, Pollution Degree 22,
Measurement Category 11
CE, UKCA:
EMC directive:
EN 61326-1 Class A Table 2 (For use in industrial locations)
compliant,
EN 61000-3-2 compliant, EN IEC 61000-3-2 compliant,
EN 61000-3-3 compliant,
EN 55011 Class A, Group 1 compliant
Low voltage directive:
EN 61010-1, EN IEC 61010-2-030 compliant
Overvoltage Category Il or I"!, Pollution Degree 22,
Measurement Category 11
EU RoHS directive: EN IEC 63000 compliant
WEEE directive: Compliant
EMC Regulatory Arrangement in Australia and New Zealand (RCM):
EN 55011 Class A, Group 1 compliant
KC marking: KS C9811, KS C9610-6-2 compliant

*1: Overvoltage Category
Describes a number which defines a transient overvoltage
condition. It implies the regulation for impulse withstand voltage.
Applies to electrical equipment which is supplied from fixed
installations like distribution boards.
1I: Applied to standard power supply (100 - 240 VAC)
I: Applied to /P1 option (24 VDC/AC)

*2: Pollution Degree
Describes the degree to which a solid, liquid, or gas which
deteriorates dielectric strength or surface resistivity is adhering.
“2” applies to normal indoor atmosphere.
Normally, only non-conductive pollution occurs.

*3: Measurement Category Il
Applies to measuring circuits connected to low voltage
installation, and electrical instruments supplied with power from
fixed equipment such as electric switchboards.

About This Manual

* Please pass this manual to the end user. We also ask you to
store this manual in a safe place.

« Read this manual thoroughly and have a clear understanding of
the product before operation.

« This manual explains the functions of the product. It does not
guarantee that the product will suit a particular purpose of the user.

Precautions Related to the Protection, Safety, and Alteration of
the Product
The following safety symbols are used on the product and in this manual.

“Handle with care.” To avoid injury and damage to
the instrument, the operator must refer to the
explanation in the manual.

Protective ground terminal

Functional ground terminal (do not use this terminal
as a protective ground terminal.)

Alternating current

10 +-@ >

Direct current

ON (power)

OFF (power)

O

« For the protection and safe use of the product and the system in
which this product is incorporated, be sure to follow the instructions
and precautions on safety that are stated in this manual whenever
you handle the product. Take special note that if you handle the
product in a manner that violates these instructions, the protection
functionality of the product may be damaged or impaired. In such
cases, YOKOGAWA does not guarantee the quality, performance,
function, and safety of product.

* When installing protection and/or safety circuits such as lightning
protection devices and equipment for the product and control
system or designing or installing separate protection and/or safety
circuits for fool-proof design and fail-safe design of the processes
and lines that use the product and the control system, the user
should implement these using additional devices and equipment.

= If you are replacing parts or consumable items of the product,
make sure to use parts specified by YOKOGAWA.

« This product is not designed or manufactured to be used in

critical applications that directly affect or threaten human lives.
Such applications include nuclear power equipment, devices
using radioactivity, railway facilities, aviation equipment, air
navigation facilities, aviation facilities, and medical equipment.
If so used, it is the user’s responsibility to include in the system
additional equipment and devices that ensure personnel safety.

« Do not modify this product.

IM 04L42B01-02E



WARNING

Use the Correct Power Supply

Ensure that the source voltage matches the voltage of the power
supply before turning ON the power. In the case of a desktop
type, ensure that it is within the maximum rated voltage range of
the provided power cord before connecting the power cord.

Use the Correct Power Cord and Plug (Desktop Type)

To prevent electric shock or fire, be sure to use the power cord
supplied by YOKOGAWA. The main power plug must be plugged into
an outlet with a protective earth terminal. Do not disable this protection
by using an extension cord without protective earth grounding.

The power cord is designed for use with this instrument. Do not
use the power cord with other instruments.

Connect the Protective Grounding Terminal

Make sure to connect the protective grounding to prevent
electric shock before turning ON the power.

The power cord that comes with the desktop type is a three-
prong type power cord. Connect the power cord to a properly
grounded three-prong outlet.

Do Not Impair the Protective Grounding

Never cut off the internal or external protective grounding wire or
disconnect the wiring of the protective grounding terminal. Doing
so invalidates the protective functions of the instrument and
poses a potential shock hazard.

Do Not Operate with Defective Protective Grounding

Do not operate the instrument if the protective grounding might
be defective. Also, make sure to check them before operation.
Do Not Operate in an Explosive Atmosphere

Do not operate the instrument in the presence of flammable
liquids or vapors. Operation in such an environment constitutes
a safety hazard.

Prolonged use in a highly dense corrosive gas (H,S, SOx, etc.)
will cause a malfunction.

Do Not Remove Covers

The cover should be removed by YOKOGAWA's qualified
personnel only. Opening the cover is dangerous, because some
areas inside the instrument have high voltages.

Ground the Instrument before Making External Connections
Connect the protective grounding before connecting to the item
under measurement or control unit.

Damage to the Protection

Operating the instrument in a manner not described in this
manual may damage the instrument’s protection.

A\

CAUTION

This instrument is a Class A product. Operation of this instrument
in a residential area may cause radio interference, in which case
the user is required to take appropriate measures to correct the
interference.

* Exemption from Responsibility

YOKOGAWA makes no warranties regarding the product except
those stated in the WARRANTY that is provided separately.
YOKOGAWA assumes no liability to any party for any loss

or damage, direct or indirect, caused by the user or any
unpredictable defect of the product.

¢ Handling Precautions of the Software

YOKOGAWA makes no warranties regarding the software
accompanying this product except those stated in the
WARRANTY that is provided separately.

Use the software on a single PC.

You must purchase another copy of the software, if you are to
use the software on another PC.

Copying the software for any purposes other than backup is
strictly prohibited.

Please store the original media containing the software in a safe place.

Reverse engineering, such as decompiling of the software, is
strictly prohibited.

No portion of the software supplied by YOKOGAWA may be
transferred, exchanged, or sublet or leased for use by any third
party without prior permission by YOKOGAWA.

Handling Precautions of the DX

Use care when cleaning this instrument, especially its plastic
parts. Use a soft dry cloth. Do not use organic solvents, such

as benzene or thinner, or other cleansers. They may cause
discoloring and deformation.

Keep electrically charged objects away from the signal terminals.
If you do, the DX may malfunction.

Do not apply volatile chemicals to the display, panel keys, etc.
Do not allow rubber and vinyl products to remain in contact

with the DX for long periods of time. If you do, the DX may
malfunction.

When not in use, make sure to turn OFF the power switch.

If there are any symptoms of trouble such as strange odors or
smoke coming from the DX, immediately turn OFF the power
switch and the power supply source. Then, contact your nearest
YOKOGAWA dealer.

Handling Precautions of the External Storage
Medium (CF Card)

Use caution in the handling of the external storage medium as it
is a delicate product.

Write operation to storage media may fail under high-temperature
or low-temperature environments. If you are using the DX in a low-
temperature environment (around 10°C or less), use the DX after
the warm-up time (at least 30 minutes) has elapsed. If you are
using the DX under a high-temperature environment (around 40°C
or more), it is recommended that the external storage medium be
inserted into the drive when saving the data and be removed after
the data storage operation is finished.

Remove the storage medium from the drive when turning the DX
ON/OFF.

Touching the compact flash section when static electricity is built
up on the human body can lead to erroneous operation.

For the general handling precautions of the external storage
medium, see the instruction manual that came with the external
storage medium.

CAUTION

Do not eject the external storage medium while the access
indicator is illuminated. This can damage the data.

Do not access the storage medium in a place with vibrations or
shock. The storage medium or drive may malfunction.

IM 04L42B01-02E



Checking the Contents of the Package
Unpack the box and check the contents before operating the
instrument. If some of the contents are not correct or missing or
if there is physical damage, contact the dealer from which you
purchased them.

DX2000

A name plate is located on the top panel of the DX (side panel on
models with the /H5[ ] option). Check that the model name and
suffix code given on the name plate match those on your order.

NO. (Instrument Number)
When contacting the dealer from which you purchased the
instrument, please give them the instrument number.

MODEL and SUFFIX Code

Standard Accessories

The standard accessories below are supplied with the instrument.
Check that all contents are present and undamaged.

Y
5. One of these power cord types is supplied
according to the instrument’s suffix code

Model Suffix Code OZ:::a' Description

DX2004 Dagstation DX2000 4ch, 125 ms (Fast sampling mode 25 ms)
DX2008 Dagstation DX2000 8ch, 125 ms (Fast sampling mode 25 ms)
DX2010 Dagstation DX2000 10ch, 1 s (Fast sampling mode 125 ms)
DX2020 Dagstation DX2000 20ch, 1 s (Fast sampling mode 125 ms)
DX2030 Dagstation DX2000 30ch, 1 s (Fast sampling mode 125 ms)
DX2040 Dagstation DX2000 40ch, 1 s (Fast sampling mode 125 ms)
DX2048 Dagstation DX2000 48ch, 1 s (Fast sampling mode 125 ms)
Internal memory  |-3 Standard memory (400 MB)
size
External storage media -4 With CF card
Language -2 English/German/French, deg F, and DST
Options. A1 Alarm output 2 points'*

A2 Alarm output 4 points ™

IA3 Alarm output 6 points'*

IA4 Alarm output 12 points™""®"®

IA5 Alarm output 24 points™"'27"®

ic2 RS-232 interface™

/Ic3 RS-422/485 interface™

/D5 VGA output

IF1 FAIL/status output?**®

IF2 FAIL + alarm output 22 points ™79

H2 Clamped input terminal (detachable)

/H5[ ] Desktop type's

m1 Mathematical functions (including the report function)™®

N1 Cu10, Cu25 RTD input/3 leg isolated RTD

IN2 3 leg isolated RTD'®

IN3 Extended input type (PR40-20, Pt50, etc.)

P1 24 VDC/AC power supply ®

IR1 Remote control”®

PS4 24-VDC transmitter power supply (4 loops)”

PS8 24-VDC transmitter power supply (8 loops)”*®"®

1USB1 USB interface

PM1 Pulse input (including remote control and mathematical

function)™®

/cc Calibration correction function

/MC1 External input function’'®

/BT2 Multi batch function’""

ICP1 PROFIBUS-DP"

IAS1 Advanced security function

1 IA1, IA2, IA3, IA4, IAS, and [F2 cannot be specified together.
/A5 and /F1 cannot be specified together.

*3 /G2, /C3, and /CP1 cannot be specified together.

*4  IF1 and /F2 cannot be specified together.

5 jHs[]

N

Power cord UL, CSA st'd
Power cord VDE st'd
Power cord SAA st'd
Power cord BS st'd
: Power cord GB st'd
Null (/H5): Only for /P1 model (without power cord)

*6 /N2 can be specified only for DX2010, DX2020, DX2030, DX2040 and DX2048.
*7 [TPS4, [TPS8, /A5 and /F2 cannot be specified together.
*8  If/TPS8 is specified, /A4 and /F1 cannot be specified together.
*9  If /PM1 s specified, /A5, /F2, /M1, and /R1 cannot be specified together.

The ination of /A2/F1 and the of /A4/TPS8 cannot be specified together.
*10 /MC1 can be specified only for the DX2010, DX2020, DX2030, DX2040, and DX2048
*11 /BT2 can only be specified for the DX2010, DX2020, DX2030, DX2040, and DX2048.

T&AMO

No. Name Part Number/ Qty. Notes
Model
1 Mounting brackets B9900BX 2 For panel mounting
Except for the /H5[ ]
models.
2 Door lock key B8706FX 2 —
3 DX2000 Operation  IM 04L42B01-02E 1 A4 size
Guide (this manual)
Control of Pollution M 04L41B01-91C 1
Caused by the
Product
About the Usage IM 04L41B01-81Z1 1
of Open Source
Software
4 CF card B8706NQ 1 128 MB (The size and
model may change.)
5 Power cord A1006WD 1 Supplied only for
models with the /H5D
option. Maximum
rated voltage: 125 V
A1009WD 1 Supplied only for
models with the /H5F
option. Maximum
rated voltage: 250 V
A1024WD 1 Supplied only for
models with the /H5R
option. Maximum
rated voltage: 250 V
A1054WD 1 Supplied only for
models with the /H5J
option. Maximum
rated voltage: 250 V
A1064WD 1 Supplied only for

models with the /H5H
option. Maximum
rated voltage: 250 V

IM 04L42B01-02E



Optional Accessories (Sold Separately)

The following optional accessories are available for purchase
separately. If you make an order, make sure that all contents

are present and undamaged. For information about ordering
accessories, contact the dealer from which you purchased the DX.

No. Name Model Minimum  Notes
Qty
1 CF card 772093 1 512 MB
772094 1 1GB
772095 1 2 GB
2 Shunt resistor 415920 1 2500+ 0.1%
(for screw input terminal) 75 5921 1 1000Q+0.1%
415922 1 100 +0.1%
3 Shunt resistor 438920 1 250 Q+0.1%
(for clamped input 438921 1 100 Q +0.1%
terminal) 438922 1 100Q+01%
4 Mounting brackets B9900BX 2 —
5 Door lock key B8706FX 1 —
6 Remote control terminal 438227 1 Remote
controller
7 Validation document - 1 Electronic file

Style number, release number, and firmware
version number of the DX2000

Style number: This is the DX2000 hardware number that is
indicated on the name plate.

Release number: This is the DX2000 firmware number that is
indicated on the name plate. The number
corresponds to the integer part of the firmware
version number.

Example: If the firmware version number is 2.01, the release

number is 2.

Firmware version number: This number is displayed on the DX2000
system information screen. For the procedure,
see section 2.5, “Viewing the DX Information” in
the DX2000 User’s Manual (IM 04L42B01-01E).

— Release number
— Style number

Protection of Environment

Control of Pollution Caused by the Product

For details, see the Control of Pollution Caused by the Product
(IM04L41B01-91C).

Proper Disposal of This Product
This is an explanation of how to dispose of this product based on
Waste Electrical and Electronic Equipment (WEEE), Directive and
Regulation. Only valid in the EEA for EU WEEE Directive and in
the UK for UK WEEE Regulation.
* Marking
This product complies with the WEEE marking requirement.
This marking (see below) indicates that you must not discard
this electrical/electronic product in domestic household waste.
When disposing of products in the EEA or UK, contact your local
Yokogawa office in the EEA or UK respectively.

g

How to Replace and/or Dispose the Batteries

This is an explanation about the new EU Battery Directive

(DIRECTIVE 2006/66/EC)EU Battery Directive/Regulation and UK

Battery Regulation. Only valid in the EEA for EU Battery Directive/

Regulation and in the UK for UK Batter Regulation.
Batteries are included in this product. Batteries incorporated
into this product cannot be removed by yourself. Dispose them
together with this product. When you dispose this product in
the EU, contact your local Yokogawa office in the EEA or UK
respectively. Do not dispose them as domestic household waste.
Battery type: Lithium battery

Notice: The symbol (see above) means they shall be sorted out
and collected as ordained in the EU Battery Directive/Regulation
and UK Battery Regulation.

IM 04L42B01-02E



Conventions Used in This Manual Revision History

« This manual covers information regarding DX2000s that have a The contents of this manual corresponds to the DX with release
suffix code for language “-2” (English). number 4 and style number 5. For details on the functions that
» For details on how to set the language, see section 2.6, have been added or changed, see “DX’s Version and Functions
“Changing the Language” in the DX2000 User’s Manual (IM Described in This Manual” in the DX2000 User’s Manual (IM
04L42B01-01E). 04L42B01-01E).
Unit
K: Denotes 1024. Example: 768 KB (file size) Edition [DX Description
k: Denotes 1000. 2 Version 1.11 Additions and improvements to
The following markings are used in this manual. Version 1.21 functionality.
3 Release number 2 Additions and improvements to
(Version 2.0x) functionality.
Improper handling or use can lead to injury to the user or damage Style numbe.rl2 NEM'_M complllance.
4 Same as edition 3 Additions and improvements to

to the instrument. This symbol appears on the instrument to
indicate that the user must refer to the user’s manual for special
instructions. The same symbol appears in the corresponding place
in the user’s manual to identify those instructions. In the manual,

functionality.
Changed the direction of the
clamp input terminal (/H2 option).

the symbol is used in conjunction with the word “WARNING” or 5 Release number 3 Add|t.|ons land improvements to
“CAUTION. (Version 3.0x) functionality.
m Style number 3 Changed the boot ROM.
6 Release number 4 Additions and improvements to
Calls attention to actions or conditions that could cause serious or (version 4.0x) functionality. Internal memory
fatal injury to the user, and precautions that can be taken to prevent Style number 3 suffix code -3 has been added,
such occurrences. and -1 and -2 have been removed.
7 Same as edition 6 Additions and improvements to
CAUTION explanations.
Calls attentions to actions or conditions that could cause light 8 Releése number 4 Addmons. and |mpr?vements to
(version 4.0x) explanations. NLF is supported.

injury to the user or damage to the instrument or user’s data, and
precautions that can be taken to prevent such occurrences.
Note

User’s manuals are supplied by
downloading them on the web

Calls attention to information that is important for proper operation site. - -
of the instrument. Style number 4 An LCD with LED b?ck light
’ replaced an LCD with CFL back
Indicates after this mark reference to related procedure or light.
explanation. 9 Same as edition 8 Merge the manuals (IM
Bold characters 04L41B01-91C, IM 04L41B01-
Indicates character strings that appear on the screen and the 8121).
operation keys. 10 Same as edition 9 Changes of "Proper Disposal of
This Product”
1 Same as edition 10 Additions and improvements to
explanations.
12 Release number 4 Changed the style (H).
(version 4.2x) Changed the EtherNet/IP name.
Style number 5
13 Same as edition 12 Correspodence to UKCA.
14 Same as edition 12 Correspodence to EN standards.

8 IM 04L42B01-02E



Introduction to Functions

Measured Items

You can connect DC voltage, thermocouple, RTD, and ON/OFF input and measure
various values such as temperature and flow rate. The DX samples the input signals at
the scan interval to obtain the measured values. The fastest scan interval is 25 ms on
the DX2004 and DX2008 and 125 ms on the DX2010, DX2020, DX2030, DX2040, and
DX2048.

Up to four alarm conditions can be set for each measurement channel.

Data Storage Function

Display Function

Other Functions

DAQSTANDARD

There are two methods of recording measured data. One is to record the measured data
continuously, and the other is to record only when certain events occur such as alarms.
The measured data is recorded to the internal memory at a specified interval. The data in
the internal memory can be stored to a CF card automatically or manually. By connecting
to a network via the Ethernet interface, the measured data can also be automatically
transferred to an FTP server on a network.

Automatic data transfer to an FTP server

DX Il—; FTP server
[

/\/ » Internal memﬂ]< @ CF card

Measurement input = ;@

Ethernet

Measured data can be displayed as trends, numeric values, and bar graphs for each
group. In addition, the overview display can be used to display and monitor all channels
on a single screen.

|

f Ly 394.6 42,7  miln e e o s e e

Computation Function (option) Various types of computation can be performed by
assigning equations to computation channels.

FAlL/status output function (option) Outputs an alarm when the DX fails. The function
also monitors the DX status such as the remaining
amount of internal memory and outputs alarms.

Remote control function (option) A specified action is executed when a remote input
signal is applied to the terminal on the rear panel.

Security function Enables only registered users can operate the
DX. The function can also be used to prohibit key
operation.

Communication function The Ethernet interface can be used to monitor the

DX using a Web browser and transmit e-mail when
an event occurs such as an alarm. In addition,
data of devices on the network can be loaded and
displayed using the Modbus protocol.

The software program, DAQSTANDARD, can be used to display the measured data,
convert the measured data format, and create DX setup data.

IM 04L42B01-02E



Introduction to Functions

DX System Configuration

The DX can be used to configure a system as shown below.
Referenced sections are of the DX2000 User’s Manual.
Referenced pages are of this manual.

L. === PLC (programmable
P Communication Interface User’s Manual = logic controller)
N  — PC 9

PLC Communication Protocol | —

Communication Interface User’s Manual ==9

PROFIBUS-DP Communication Interface User’s Manual = T L
[° PLC con]rmunlcatlon

Ethernet | protocol

Temperature Recorder

controller PLC
Serial
communication* A\

/'RS-232, RS-422/485, or PROFIBUS-DP*t

Measurement
{< JTz input »

P Sec. 3.3

Pulse input* » DX2000 » CF card

P Sec. 3.10 P Page 24
r
. USB flash memory
rensmitervong uepy @ <= ussrore | €7 VR
P
<— Keys
Alarm output* « S Iﬁeyst;zarzd"
P Sec 3.5-3.8 . 2.
@\ Barcode reader’
L p Sec. 2.11
FAIL/status output* « . D
pSec. 2.9 Remote Terminal* w
P> Sec. 2.10 S

Remote input*
P Sec. 7.1

Monitor*
P Page 62

Y+ 1t

*: Option
1: Release number 3 or later

Terminology
* Memory sample

The operation of recording measured data.
* Memory start
The operation of starting memory sampling.
* Memory stop
The operation of stopping memory sampling.
* Display data
The waveform data shown on the DX display. The data recorded at the sampling
interval for the displayed data.
* Event data
Measured data recorded at a sampling interval separate from that of the display data.

10 IM 04L42B01-02E



Names of Parts

Front View
Key panel opened

LCD

Display various operation
displays such as the trend
display as well as setup
displays.

Front cover (Key panel)
Open the front cover by pulling
the cover while holding down
the tab at the center of the
upper section of the cover.

Power indicator

llluminates in red when the
power is turned ON. llluminates
in green while memory
sampling is in progress.
Remote control sensor ————
(/KB1 and /KB2 options)
Receives infrared light from the
remote control terminal.

CAUTION

When closing the front cover, press
the front cover in until the tab at the
center of the upper section of the
cover is all the way up. If the front
cover is not closed completely, the

Key panel cover water and dust proof capability may
Label (front of the key panel cover) Open the cover by pinching the be impaired.
Write arbitrary labels for your left tab and pulling forward.

convenience.
Front cover opened

USB port CF card slot
A USB port conforming to Rev.
1.1.
— [ N CF card access indicator
Power switch —— ] 5 5 s 5
a | CF card eject button
Used when ejecting the CF
Ty = card.
Door lock key (included)
Insert the pin in the left hole to lock.
Insert the pin in the right hole to unlock.
A7/
[ V I

IM 04L42B01-02E 11



Names of Parts

Rear Panel

USB port (/USB1 option)
A USB port conforming to
Rev. 1.1.

Ethernet port
A 10Base-T port.

VGA output connector
(/D5 option)

A connector for an
external monitor.

Serial interface port
(/C3 option)

A RS-422A/485 interface
connector.

Power supply terminal and
protective earth terminal.

PROFIBUS-DP port
(/CP1 option)
PROFIBUS connector.

[ E=E
Serial interface port
(/C2 option)

A RS-232 interface
connector.

Optional terminals (/A[ ], /F[ 1,

IR1, ITPS] ], and /PM1 options)

Connect optional input/output

signal wires.

Input terminals (screw terminals

or clamped terminals (/H2 option))
Connect input signal wires from the

measured item.

Functional ground terminal

Power connector

12
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DX2000 Workflow

Installation

Wiring

Power ON

Environmental
Settings

RRRl
U

Functional
Settings

Measurement

L14
ups

Data
Management

CF Card
Insertion

y

Use
Registration

Ja 4]
[t

Environmental

ettings

[7]
2 =

Functional
Settings

Measurement

Ailde
ujs

Data
Management

When using the DX for the first time, carry out the following procedure.

Install the DX.
P> Page 49 and subsequent pages

Connect input/output wires to the terminals and connectors on the
rear panel, and connect the power cord.
> Page 52 and subsequent pages

Turn the power ON.
» Page 13

Set the date/time, load the CF card, and so on.
P Page 18 and 24

Set measurement functions.
P Page 19 and subsequent pages, page 28 and subsequent pages

Start the measurement. Perform operations such as switching the
screen and writing messages. Save the measured data.
P Page 39 and subsequent pages

Check and manage the measured data.

Use the software program, DAQSTANDARD, to display

the measured data and convert the measured data to Excel, Lotus, and
ASCII formats.

P Page 48

P DAQSTANDARD Viewer User’s manual (IM 04L41B01-63EN)

On a DX with advanced security (/AS1 option; release number 4 or later), carry out the
following procedure after turning the DX on.

Insert a CF card into the DX.
P Page 24

Register the users who will operate the DX.
B Advanced Security Function (/AS1 option) User’s Manual
(IM04L41B01-05EN)

Set the date/time.
p Page 18

Set measurement functions.
P Page 19 and subsequent pages, page 28 and subsequent pages

Start the measurement. Perform operations such as switching

the screen and writing messages. Save the measured data.

P Page 39 and subsequent pages

Check the measured data, and attach approval information

to the measured data file.

P Advanced Security Function (/AS1 option) User’s Manual
(IM04L41B01-05EN)

You can also attach approval information to the measured data file
by using the software program, DAQSTANDARD.

» DAQSTANDARD Viewer User’s Manual (IM 04L41B01-63EN)

IM 04L42B01-02E
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Turning the Power ON/OFF

Turning the Power ON

A CAUTION

Before turning ON the power switch, check that

* The power cord/wires are connected correctly to the DX.

« The DX is connected to the correct power supply (see page 64).

If the input wires are connected in parallel with other devices, do not turn ON/OFF
the power switch of the DX or another device during operation. This can have
adverse effects on the measured values.

=

Open the operation cover.
2. Turn ON the power switch.
After performing a self-test for a few seconds, the operation screen appears.

3. Close the operation cover.

A CAUTION

 If nothing is displayed when the power switch is turned ON, turn OFF the
power switch and check the points listed above one more time. After checking
the points, turn ON the power switch again. If the DX still does not work, it is
probably a malfunction. Contact your nearest YOKOGAWA dealer for repairs.

» If an error message is displayed on the screen, take measures according to the
description in chapter 11, “Troubleshooting” in the DX2000 User’s Manual.

» Turn ON the power switch, let the DX warm up for at least 30 minutes, and then
start the measurements.

Turning the Power OFF

A CAUTION

Before turning OFF the power switch, check that the external storage medium is
not being accessed.

1. Open the operation cover.
2. Turn OFF the power switch.

3. Close the operation cover.

14 IM 04L42B01-02E



Basic Operation

Panel Keys

o LCD

Key panel

DISP/ENTER key and four arrow
keys (up, down, left, and right)

Soft keys Switches the operation screen.
Selects the menu that is Selects and enters setup items.
displayed at the bottom of the —

screen. — DISP/ENTER key

Up arrow key

START/STOP key —{@s™1)

Right arrow key
Memory start/stop.
4‘ > Down arrow key
Left arrow key
ESC key _ Character/Number input keys
Cancels an operation. Enters characters and numbers.
USER key .
. MENU key Favorite key
Executes the assigned : .
operation 9 Switches between the operation  Displays the operation screen (up to
p : mode and setting mode. eight screens) that are registered to
the key.
FUNC key
* Displays the soft key menu in operation mode.
» Hold down this key at least 3 s in the setting mode to switch from the setting
mode to the basic setting mode.
Display
Sh0by 1201 01:53:07 Dise I nin  (S)EH = Status display section
1nin/dio 500 | ) Shows the display name, date/time, data

recording, alarm icon, etc.

kaz| ( Data display section
97.17 | | Shows the measured data and the functional setup

8.4é: display.

For the waveform display and numeriuc display, see

@:47 (EkGEs @151

il 1:43 o145

Waveform display

y
180.55 section 4.2, in the DX2000 user’s Manual (IM
2 04L.42B01-01E). For details on how to set the scale,
y see section 5.7, in the DX2000 user’s Manual (IM
42.5 | ] 04L42B01-01E).

Numeric display

IM 04L42B01-02E
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Basic Operation

Display on the Status Display Section

The following information is displayed in the status display section.

Memory sampling status

Data type
DISP: Display data
EVENT: Event data

i Memory sampling !
' stopped Memory sampling progress ;
1 & Displays the progress using a green bar graph. The frame indicates the file save !
Memory sampling g interval (display data) or the data length (event data).

in progress = Error in internal memory.
m Contact your nearest YOKOGAWA dealer for repairs.

Memory sampling icon Displays the remaining memory sampling time for the left bar graph.

GROUP 1 ALL
2005/09/22 10:57:53

63 oise LM dnin

|
Alarm icon
m Displayed when any alarm is activated.

Blinks when there are alarms that are
(Red)  occurring but have not been acknowledged.

(Green)

Display name or group name
For all channel display on the trend display,
“ALL” is displayed.

Date and time
Displayed in yellow while the time is being corrected. All alarms have been released after they
have occurred, but there are alarms that

have not been acknowledged.

When using the batch function

P1-process-AAAAA3 Batch name (shown alternatelyi
with the display name) ‘
Date and time

If the “batch number-lot number” exceeds 20
characters, the “date and time” position is used to

When using the login function

Status icon
m The status assigned to the status output
(/F1 or /F2 option) is occurring.

User Locked Icon (/AS1 option)
Displayed when the user is locked.
ral

Name of the user logged in
Display name
Date and time

ﬂ Keys are locked.

E E-mail transmission is enabled.

When using the login and batch functions

Name of the user logged in

Batch name (shown alternatelyi

with the display name) ] Yellow icon: Computation dropout occurred
[g: CF card is being accessed.

The green level display indicates the amount of —»-g Waiting.

Computation icon (/M1 or /PM1 option)
White icon: Computation in progress

} display the “batch number-lot number.”

Date and time

CF card used. If Media FIFO* is not enabled and @ Light blue icon: CF card in the slot is not
the free space on the CF card falls below 10%, recognized. Remove and reset it.
the level indicator changes to red. @ CE card error.

* See section 1.4, in the DX7000/DX1000N User’s
Manual. Media FIFO is a function available on
release number 2 or later.

Carry out the procedure below to reset the CF card icon to

normal.

* Remove the CF card, and then reinsert it.

* Replace the CF card with a normal one.

» Format the CF card on the DX (the data on the CF card
will be erased).

16 IM 04L42B01-02E



Basic Operation

Run Modes

Mode Transition Diagram

Power ON

'

Operation mode

G |
J005/1201 01:55:
Inin/éiv

S

etting mode

Basic setting mode

End menu > DISP/ENTER or
ESC > DISP/ENTER
(release number 3 or later)

2008/1291 09:49°53

5 i N e

= | File 1 :II»(M | T File/Initialize |

) MENU key = ) Hold down FUNC | ;2" ,
8 w=m (( Setting menu for3sor o Basic setting
v — i 'Y‘“;u;nm displa.y Basic Setting Mode o menu display

; MENU key . : > DISP/ENTER
5. or ESC key e st e (release number 3
0 1l 1 or later)
T ! [ L
. DISP/ENTER MENU key DISP/ENTER 1
On a DX with advanced security key or ESC key key ESC key

(/AS1 option; release number 4 or later):

MENU key or ESC key > DISP/ENTER

or

End menu > DISP/ENTER

GP |
2008/12) 09:52:53

2 v N thor

The DX has three modes.

Mode

Description

Operation mode

A mode for performing measurements.

Setting mode

A mode in which input range, measurement method, and so on
are configured. Settings can be changed when memory sampling
is in progress excluding some items.

Basic setting mode

A mode used to set basic items such as the scan interval and
storage format of measured data. On a DX with advanced
security (/AS1 option; release number 4 or later), the login
settings can be changed during memory sampling.

* For further details on the basic setting mode and setting mode, see page 67.

Carry out the steps given in the following pages. It will help you to understand the DX

operation.

Entering Values and Characters
The character/number input keys and DISP/ENTER key are used to set the date/time,

set the display span of the input range, set the tag, set the message string, enter the

password, etc.

Character/Number input keys

DISP/ENTER key and four arrow
keys (up, down, left, and right)

IM 04L42B01-02E
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Basic Operation

Entering Values

When a window for entering a value appears, enter the value by performing the following
key operation.

e Left and right arrow keys: Selects the input position.

e Character/Number input keys: Enters a value.

The following soft key appears when it can be used.

* Space soft key: Enters a space.

Entering Character Strings

Space

When a window for entering a character string appears, enter it by performing the
following key operation.

* Left and right arrow keys: Selects the input position.

e Character/Number input keys: Enters a character string.

The character to be entered is determined by the number of times the A/a/1 soft key and
the character/number input key is pressed. The character types that can be entered vary
depending on the item being set.

Del Bs Ins Asa’1

Input status of the A/a/1 soft key

Input status of the Ins soft key

* Space soft key: Enters a space.

e Del soft key: Deletes the character at the cursor.
* Bs soft key: Deletes the character before the cursor.
* Ins soft key: Selects insert or overwrite.

Insert and overwrite mode toggles each time the Ins soft key is
pressed. The selected mode is shown on the right side of the soft
key display section.

* Alal1 soft key: Selects uppercase alphabet (A), lowercase alphabet (a), or value (1).
The character type that you can enter changes each time you press
the A/a/1 soft key. The selected character type is shown on the right
side of the soft key display section.

18
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Basic Operation

The contents of the screens in the operation examples below may change depending on
which options are installed and how the settings are configured.

On a DX with advanced security (/AS1 option; release number 4 or later) you must first
insert the CF card into the slot (see page 24).

Changing the Date/Time

In this example, we will change the date to the 14th. After carrying out this step, reset the
time to the correct date/time.
1. Display the operation mode screen.
S van g2z R VISP N onin  (3)
v
0.00008
2 ]

v
. 60RO

[ v

0. 0000

— v

1. BYBY

- | 0.0000

]
0.60680
]
8.6080
y
0.6080
]
0.6080
0.60680
Press MENU once to display the setting menu.

3. Press the down arrow key once. The cursor moves to Date/Time.
4. Press the right arrow key once.

GROLP 1 =
Sty 1/m po:sa:es el DisP I 1hor  (T)

Henu ] File 1

* Select Time settings.

73 Gl Daylisht Saving Tine

Hath channel v

Ext. channel »

Display »

Group set, Trip line

Hessage, Comnent Text »

Timer, Event action »

Data save 4

Henu custonize »

Basic setting mode

5. Press DISP/ENTER once to open the Time set window.

IM 04L42B01-02E
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Basic Operation

6. Setthe date to 14.
Select the input position: Left and right arrow keys

Change the value: Character/Number input keys
Enter the input: DISP/ENTER
Cancel the setting: Press ESC before pressing DISP/ENTER.

GROLP 1 =
S0, 12/01 po:sacse g D1 NN 1o (D)
Henu 1 File 1

Heas channel Naulioht Qanina Tima

Hath channel

5. ol Berio/1d 0T-38:

Display

Grouw set, Trip line
Hessage, Comment Text
Timer, Event action
Data save

v v v w

Henu custonize
Basic setting mode

Display the Time set
window.

7. Press ESC twice or MENU once to return to the operation mode screen.

On a DX with advanced security (/AS1 option; release number 4 or later):

Press ESC twice or MENU once to display a confirmation screen. To return to the
operation mode screen, select Yes, and press DISP/ENTER once.

Operation complete.

Operation Example in the Setting Mode: Changing the Input Range
Set the input range of channel 2 to thermocouple type T and 0.0 to 400.0°C.

DX2000

Type T
thermocouple Channel 2
-

1. Display the operation mode screen.

GROLUP 1 = :
2805/12/81 p2:02:00 ‘e D157 I l6nin

i
6.0000
2 TN
. 0eeg
3 I
. 600a
M v
6. 00080

. Bﬂﬂ
. Bﬂ
. Bﬂﬂé
5 BBIJ

. 0008

2. Press MENU once to display the setting menu.

20
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Basic Operation

3. Press the down arrow key twice to select Meas channel.
4. Press the right arrow key once.

GROUP 1 =
SR g 1n-gi-1s ed Do NN lhor (5]

Henu ] File 1
Date/Time »
» Select Range, Alarm
X .

Hath channel
Ext. channel

Tag, Hemory sample, Alarm delay

Hoving average

Disnlay
Group set, Trip line Color
Hessage, Comment Text Zone. Scale. Bar graph

Timer Event action Alarn mark. Color scale band

Data save
Calibration correction
Henu custonize .

Basic setting mode

5. Press DISP/ENTER once.

GROUP 1 =1
SR v w5t e D1 N e (D)
Heas channel > Range, Alarn

First-CH E@I Last-CH ]

r Range Select First-CH.
Hode Range Span Lower  Span lpper
Yolt ] -2. 6888 2.0@a8

r Alarn
1 off
2 |0
3 |0
4 | 0ff

Input +1 -1

6. Press the +1 soft key once to set First-CH and Last-CH to 2.

7. Press the down arrow key once to move the cursor to Mode.

8. Press the TC soft key once. The cursor moves to Range, and the changed items
are displayed in yellow.

GROUP 1 = :
onms1zm pepaila e DISP I 16nin @

Heas channel > Range, Alarm
First-CH [682 Last-CH BE2

r Range
Hode Range Span Lower  Span Upper
T?C [X] 1768.8

Select TC.

r Alarn

[off"
[off"
[off_
[off

R $ B K 3 J Next 1/2

[N AT

9. Press the Next soft key.
10. Press the T soft key once. The cursor moves to Span Lower.

IM 04L42B01-02E 21



Basic Operation

11. Press the Input soft key once.

GROUP 1 &
e g1z el S N tor (D) )
Heas channel > Range. Alarn

First-CH [B82 Last-CH [

r Range

Hode Range Span Lover  $pan lpper
TC T -208.8 4AR.A
J-280.8

&1 Display the span lower
setting window.

r Alarn

0ff
0ff
0ff

oFF
En

€3 1

12. Enter 0.0 in the Span Lower box.

Select the digit: Left and right arrow keys

Change the value: Character/Number input keys

Delete the value:  Space soft key

Cancel the setting: Press ESC before pressing DISP/ENTER.
13. Press DISP/ENTER once. The cursor moves to Span Upper.
14. Enter 400.0 in the Span Upper box.

See step 12 for the procedure.

15. Press DISP/ENTER once. The changed items are entered, and the cursor returns
to First-CH. The changed items change from yellow to white.

GROUP 1 =
b/ o067 0 Dl N hor (D)
Meas channel > Range. Alarm

First-CH Last-CH 7
r Range
Hode Range Span Lower  Span Lpper
TC T 8.8 408.8
r Alarn

0ff
i

A
olo|e
2=

-] -] i

Input + -1

16. Press ESC three times or MENU twice to return to the operation mode screen.
On a DX with advanced security (/AS1 option; release number 4 or later):

Press ESC three times or MENU twice to display a confirmation screen. To return
to the operation mode screen, select Yes, and press DISP/IENTER once.
Operation complete.
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Basic Operation

Operation Example in the Basic Setting Mode: Changing the Scan Interval
In this example, we will change the scan interval. Here, the scan interval on the DX2010

is changed to 2 s. The selectable scan intervals are different on the DX2004 and

DX2008, but the procedure is the same.

DX2000
Measures every 2 s I
Type T
thermocouple  Channel 2
S

FEEO

1. Display the operation mode screen.
GROUP 1 = .
2005/12/81 2:39:89 OIsP N 1inin

Inin/div

2. Press MENU once to display the setting menu.

b/ 1p:e:z7 o 0 N 1rowr
[ Henu || File 1
Date/Time
Heas channel
Hath channel
Ext. channel

v v v v w

Display

Groun set, Trip line
Hessage, Comment Text
Timer. Event action

Data save

v v v v

Henu custonize
Basic setting mode

®

3. Hold down FUNC for at least 3 s.

Basic Setting Hode

Environnent | INTSTINNNN || File/Initialize |
Alarn

A/D. Memory

Burnout, RJC

Report »

Tine settings
Connunication (Ethernet} »

b4

Connunication (Serial)
End

&—— Display the basic setting
mode menu

Alternatively, you can
execute the following
procedure to switch to
Basic Setting mode.

Use the up or down arrow
key to select Basic setting
mode on the Menu tab,
and press DISP/ENTER.

A confirmation window will
appear. Select Yes, and
press DISP/ENTER.

4. Press the down arrow key twice to select A/ID, Memory.

IM 04L42B01-02E
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Basic Operation

5. Press DISP/ENTER once.

A/D, Henory

Scan interval

Scan mode

Scan interval 1s

A/D intesrate Auto

Hemory
’]Jata kind Display

Press the down arrow key once to move the cursor to Scan interval.
7. Press the 2s soft key once. The cursor moves to A/D integrate, and the changed
item is displayed in yellow.
Cancel the setting: Press ESC before pressing DISP/ENTER.
8. Press DISP/ENTER once. The changed items are entered, and the cursor returns
to Scan mode.

o

A7D, Hemory

—  Scan interval

Scan mode
Scan interval is e Set the scan interval to 2 s.
A/D intesrate Auto
- Hemory —
Data kind Display

9. Press ESC once to return to the basic setting mode menu.
10. Press ESC once more.
Alternatively, use the up or down arrow key to select End, and press DISP/ENTER.

Basic Setting Mode

Environnent | Henu | FilesInitialize |
Alarn

Burnout. RJC

Report

Time settings _ ] -
Connunication - Display the confirmation
onnunicat ion i

Conmunication ¢ No Cancel window.

End

11. Press DISP/ENTER once. The settings are saved, and the DX returns to the

operation mode screen.
Discard the changes: Select No and press DISP/ENTER.
Do not end the basic setting mode: Select Cancel and press DISP/ENTER.

Operation complete.
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Inserting/Removing a CF Card

Inserting a CF Card
1. Open the operation cover.

g 7'ZCF card

2. |Insert the CF card into the slot.

GROUP 1

&=
oags/12/m mozaic1g  ped DI N lhour

3. Close the operation cover.

Operation complete.

Removing a CF Card
<Operations in the Operation Mode>
1. Press FUNC once.

2. Press the Media eject soft key once.

GROUP 1

o=
oag5/1o/e1 a2-41-24  “red DISP NN lhour

CAUTION

Forcing the CF card into the slot with
the upside down may cause damage.

With the label “This side up”
Qacing up

@ Displays the storage
N Y|  mediaicon.
0. 66680
2 |

0. 66609

te]

Storage media icon

[
8.00680
A
0.0000
B
0.0060
v
0.0000
y
0.0000
y
0.0000
y

Hedia
eject

Snap

AlarnACK | Message e
shot

nessage

Hanual
sanple

— Media eject

5%
v
00800

Next 1/2 -
h.
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Basic Operation

3. Press the CF soft key once. The message “Media can be removed safely”
appears.

4. Open the operation cover.

5. Press the CF card eject button. When you eject the CF card, the CF card icon
disappears.

Press the eject button in until it clicks.
The eject button stops at depressed
position. Pinch the left and right side
of the CF card and remove it.

g4

7L Eject button

6. Close the operation cover.

Operation complete.

<Operation in the Basic Setting Mode>
1. Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to
basic setting mode), select the File/Initialize tab > Media eject > CF *, and press

DISP/ENTER.
* Select CF if you have a choice between CF and USB.

Basic Setting Hode

Environment | tenu ] FilesInitialize |
Load settings
Initialize

End

The message “Media can be removed safely” appears.
2. Open the operation cover.
3. Press the CF card eject button. Remove the CF card.

4. Close the operation cover.

Operation complete.

Note

If you remove the CF card without carrying out the media eject procedure, the message “Media
was removed compulsorily” appears. Remove the CF card by carrying out the procedure above
to prevent damaging the data that is stored.
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Saving the Setup Data

In this example, we will save the setup data to a file named “SF2” on the CF card.

1.

o

Display the operation mode screen.

GROUP 1 =
oaps12/01 go-ai:1g  hed DISP NN 1hour

[ v
8.

I v
i

- | 00000

8.0000

v

9. 608

v

8.0000

v
. 608
8.0008

Press MENU once to display the setting menu.
Press the right arrow key once to select the File tab.
Press the down arrow key four times.

o 19:15:50 e DS I thor (3]
Henu | File |
Load display data
Load event data
Load settings

| Save settines [ Select Save settings.
Custon display load »
Custom display save »
File list/delete
Format

Press DISP/ENTER once.
Enter “SF2” for the file name.
For the input procedure, see “Entering Values and Characters” on page 16.

GROLP 1 =
SR it mrazegs G D N o [D)
Save/Load > Save settings

Save settings
’7File nane CF:/ [5F2

Space Del Bs Ins frarl

4

Press DISP/ENTER once. The message “Data are being saved to media’
appears, and the setup data is saved.
Press ESC or MENU twice to return to the operation mode screen.

On a DX with advanced security (/AS1 option; release number 4 or later):

IM 04L42B01-02E
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Basic Operation

Press ESC or MENU twice to display a confirmation screen. To return to the
operation mode screen, select Yes, and press DISP/ENTER once.

Operation complete.

Loading the Setup Data

In this example, we will load the setup data “SF2” from the CF card and update the DX
settings.

This procedure only loads the setup data that the DX uses for setting mode.To load the
setup data for both setting mode and basic setting mode, press MENU, hold down FUNC
for 3 s, select the File/Initialize tab > Load settings, and press DISP/ENTER.

Display the operation mode screen.
Press MENU once to display the setting menu.

Press the right arrow key once to select the File tab.

P w N~

Press the down arrow key three times.

s/ 10:22-32 e i N 1hor  (S)
Henu 1 File |
Load display data
Load event data

> Select Load settings
Save settings
Custon display load »
Custon display save »

File list/delete
Format

5. Press DISP/ENTER once to select the root directory (CF:/).
6. Press DISP/ENTER once to display the files in the root directory.

7. Select the file SF2 using the up and down arrow keys.

GROUP 1 —
SR gl ta:osea oA 0P NN o (D)

Save/Load > Load settings

7 To move to a lower
File name Date / Tine directory, select the

SF2.PDL 2088/12/81 10:20 directory, and press

DISP/ENTER.

To move to a higher
directory, press ESC.

Free space 121997 Kbytes
Sort

8. Press DISP/ENTER once. The message “File is being loaded from media”
appears, and the setup data is loaded. The DX automatically returns to the
operation mode screen.

Operation complete.
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Setting the Input Range and Alarm

Setup Example 1: Temperature Measurement Channel

DX2000
\ \
Type T
thermocouple  Channel 1
- i
0.0 to 200.0°C 0] We)
Setup Item Description Number in the Figure
Channel Use channel 1. 1
Tag TI-001 2
Sensor Type T thermocouple 3
Input range 0.0 to 200.0°C 4

(1) Input Range
Press MENU (to switch to setting mode).
Select the Menu tab > Meas channel > Range, Alarm.

GROUP 1 =]
bl 102004 e Ol I 1o (D)
Heas channel > Range. Alarm

First-CH [@] Last-CH l@

r Range 1
Hode Range Span Lover  Span Lpper
¢ TB. 2?8.
4
3
- Alarm
1 |off
2 | 0ff
3 | 0off
4 | off
Input +l -1
(2) Tag

Select the Menu tab > Meas Channel > Tag, Memory sample, Alarm delay.

GROUP 1 =1
2a88/12/81 19:32:00  ed DISP NN 1hour =
Heas channel > Tag, Hemory sample, Alarm delay

First-CH Last-CH [}

Tag
(Characters 1-801 o | 2

{ Hemory sanple

On/0f On
Alarn delay
{Time 18s
Input +1 -1

Operation complete.
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Setting the Input Range and Alarm

Setup Example 2: Flow Rate Measurement Channel and Alarm

DX2000
[ [

Flowmeter Channel 2

! 4-20mA /

Convert to 1-5 V with a shunt resistor

Setup Item Description Number in the Figure
Channel Use channel 2. 1
Tag FI1-002 2
Input signal 1-5V 3
Input range 0.0 to 500.0 L/H 4
Alarm condition Output an alarm if the measured valueis 5

less than or equal to 120.0 L/H.
Output destination: Relay contact (103)

(1) Input Range and Alarm
Press MENU (to switch to setting mode).
Select the Menu tab > Meas Channel > Range, Alarm.

GROUP 1 1
Sim 10450 e D1 N hor (5] )
Heas channel > Range, Alarm

First-CH E@ Last-CH W

r Range 1
Hode Range Span Lover  Span Upper
1-aV 1-5V 1. 800 5.008
Scale Lover $Scale Upper Lnit
,B.B ,SBBB L/U,
Low-cut 4
off
r Alarm
Relay
Tupe Value On/0ff  Number
1 |0On L 126.8 On 183
2 [off * * * *
3 [of 5
4 | 0ff
Input 41 -1
(2) Tag
Select the Menu tab > Meas Channel > Tag, Memory sample, Alarm delay.
GROUP 1 &
a2 10:a055 G 1S I hor  (5) )
Meas channel > Tag, Memory sample. Alarn delay
First-CH Last-CH BB2
Tag
(Characters FI-082 o 1 2

( Hemory sample

On/0ff On

Alarm delay
(Time 18s

Input + -1

Operation complete.
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Setting the Display

Setup Example 3: Assigning Channels to Groups

In this example, we will assign channels 1 and 2 to group 1.

L Group 1
GROUP 1 = .
2885/12/81 B2:49:25 DIsP I 43nin

1nin/div

Channel 1

Channel 2

Setup Item Description Number in the Figure
Group Assign channel 1 and 2 to group 1. 1
(1) Group
Press MENU (to switch to setting mode), and select the Menu tab > Group set, Trip
line.
GROUP 1 & .
S pare R O N tor () W
Group set. Trip line
Group nunmber 1
Group set
On/0ff h e
Group name GROUP 1 ®
CH set [901-g82 °
r Trip line
1 OFf
2 OFf
3 OFf
4 Off
Input + -1

Operation complete.
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Setting the Display

Setup Example 4: Setting the Time Scale

Set the time per division of the trend waveform to 2 minutes.

253'5';1'2,31 82:11:15 G5 oisp I 3inin @ 1  The sampling interval (the time
AO0 200 | corresponding to 1 dot) is 4 s

w I I 27.6/ when the trend interval is 2 min.

T/ 30 dots x 4 s =2 min

200
L 2

150
EI1]

L 1|

1330 13224 19:22 19:32 133 oz ez {f
>

30 dots/div

100

f50
00
H 100

Setup Item Description Number in the Figure
Trend interval Set the time per division to 2 minutes. 1
The waveform is updated at every 4 s.

(1) Trend Interval
Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend/

Save interval.

GROLP 1 =
e s e U HEEEEE - (5) o)

Display > Trend/Save interval

Trend / Save interval

Trend interval [/div] | 2nin__| 1

Save interval 1h

Operation complete.

32 IM 04L42B01-02E



Setting the Data Storage

Setup Example 5: Continuously Record Measured Data and Automatically Save

In this example, we will continuously record and save the measured data of channel 1
and 2.

For the procedure to set the channel, see “Setting the Input Range and Alarm” on page
28.

For the procedure to set groups, see “Setting the Display” on page 30.

GROUP 1
20p5/12/8] B2:11:15

2nin/div

DIsP NI 36nin

¢[<— Channel 1

L/H<— Channel 2

Automatically save to
the CF card periodically.

<>

Setup Item Description Number in the Figure
Source channels Channel 1 (TI-001) and channel 2 (FI-002) 1
Data to be recorded Continuously record the display data from the start of the 2
measurement.
Data storage method  Automatically store every 24 hours. 3
Sampling interval 4 seconds. Set using the trend interval. 4

Sampling interval = (trend interval setting)/30 dots”
* 40 dots when the trend interval is set to 5 or 10 seconds.

Data file name Add “sample” to the file name. 5
Example: 000123 _sampleYYMMDD_HHMMSS.DAD
1 1
Sequential number Date/Time of the first recorded data
Save Destination DATA-101 6
Directory

(1) Data to be Recorded
Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
setting mode).
Select the Menu tab > A/D, Memory.

Basic Setting Mode

Sean interval

Scan mode
Scan interval 25

A/D integrate Auto

Henory —|
(Data kind Display® | 2

Nornal
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Setting the Data Storage

(2) Method of Storing to the CF Card (Auto Save ON/OFF)

Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic

setting mode).

Select the Environment tab > Security, Media save, Batch.

Basic Setting Mode

Environment > Security, Hedia save. Batch

r Security E—
Key
Comnuni cation off

r Save —_—
fAuto save [T
Hedia FIFO off

r Batch
on/0ff off

off Login | Keylock

(3) Save the Settings

1. Press ESC to return to the basic setting menu.

Press ESC once more.

The window appears for you to confirm the saving of the settings.
3. Select Yes and press DISP/ENTER.
The DX returns to the operation mode screen.

(4) Channels to Be Recorded
Press MENU (to switch to setting mode).

Select the Menu tab > Meas Channel > Tag, Memory sample, Alarm delay.

GROUP 1 =
2088/12/01 10:48:45 oo D1SP NN lhour

Meas channel > Tag, Memory sample, Alarm delay

First-CH Last-CH

$2

Tag
’7Character‘s F1-662
Memory sanple —‘
’70n/ﬂff 0n e !

Alarn delay
’7Time

18 s

Input +1

34
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Setting the Data Storage

(5) Interval for Saving the Data to the CF Card
Select the Menu tab > Display > Trend/Save interval.

GROLP 1 =
i gizse R D N 1w (O) o)

Display > Trend/Save interval

Trend / Save interval

Trend interval [/divl | onin_ ! 4

Save interval lday @ 3

38s Inin 2nin Smin 1Bnin 15min  |Next 1/2

(6) Data File Name

Select the Menu tab > Data save > File header, Data file name.

GROLP 1 & .
S m ponsca e DI NN thor (5] »
Data save > File header, Data file name
File header
(Characters | ‘

Structure Date

’, Data file name

Identified strings [sanple ° 5

Input Clear Copy

(7) Save Destination Directory (within the CF Card)
Select the Menu tab > Data save > Save directory.

GROUP 1 =] x
o bl g5t e Ui I sor  (S) 0}
Data save > Save directory

Save directory —|
’7 DATA-181 6

Directory name |

Input Clear Copy

Operation complete.
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Setting the Data Storage
Setup Example 6: Saving Measured Data at the Specified Time

Using the settings of Setup Example 5, we will save the measured data once at hour 0

every day.
Ev hour 0

3 f R Automatically save
to the CF card

DX2000
[

e @

o

All settings other than those listed below are the same as Setup Example 5.
Number in the Figure

Setup Item Description
Data storage time Save the data once at hour 0 every day. 7
Automatically save the measured dataat 8

Data storage method
the specified time.

(1) Setting the Time
Press MENU (to switch to setting mode).
Select the Menu tab > Timer, Event action > Match time timer.

GROUP 1 1
S itm 1050 e D1 NN hor (5] )
Timer, Event action > Match time timer
Timer nunber
Hatch tine timer ———————
Kind Day @ 7
Day 1 @&
Hour:Hinute [[HIES
Timer action Repeat @
Input +H -1

(2) Specifying the Data Storage
Press MENU (to switch to setting mode).
Select the Menu tab > Timer, Event action > Event action.

o:))

GROUP 1 =
esrio/m 1a:5oas e DI N thr ()

Timer, Event action > Event action

Logic box number

Event-fiction
Event HatehT i meT imer [ I 8
Match Tine Timer No. 1 C |
Action SaveDisplay .
Input +1 -1

Operation complete.
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Customizing the Operation

Setup Example 7: Assigning the Screen Image Data Storage Function to the
USER key

In this example, we will set the DX so that the displayed screen image data can be saved
to the CF card by pressing the USER key. This function is called snapshot. The extension
of snapshot data files is .png.

USER key

Setup Item Description Number in the Figure
Event action Save the screen image data of the DX 1
using the USER key.

(1) Assigning an Action to the USER Key
Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event
action > Event action.

GROLP 1 =)
Soeyvm oo e U1 I e (S) on)

Timer, Event action > Event action

Logic box number | 2]
Event-Action

Event [ UserKey C 1
I o

fction Snapshot

Input +H -1

Operation complete.
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Customizing the Operation

Setup Example 8: Registering Frequently Used Screens to the Favorite Key
Up to eight operation mode screens that are frequently used can be registered to the

Favorite key. This enables you to monitor the operation by using only the Favorite key.
This feature is convenient when comparing data such as historical trends.

Example when three screens are

registered to the Favorite key
B ppse T 0 N e ()

Favorite key

Favorite key I

T~
O
| E : =
oy 166. 6

Favorite key Favorite key RN .

s

Favorite key

1. Display the screen to be registered.

GROUP 1 =
200571201 g2:15:56 e D1 N 14

2. Press FUNC once to display the FUNC key menu.
3. Press the Next soft key to display Favorite regist.
4. Press the Favorite regist soft key to display the registration list window.

GROUP 1
2885/12/81 B2:17:30 oisP N 1day

Show the registration list
window.

38
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Customizing the Operation

5. Press the favorite number (1 to 8) soft key.

6. Press the Regist soft key.

GROUP 1 =
o512/ peeiniog e DISP I lcay

Show the window for
entering the display name.

7. Enter the screen name.

Select the digit: Left and right arrow keys

Enter characters: Character/Number input keys

Delete a character: Del soft key or Bs soft key

Cancel the setting: Press ESC before pressing DISP/ENTER.

For the input procedure, see “Entering Values and Characters” on page 16.
8. Press DISP/ENTER once.

9. Repeat steps 1 to 8 to register up to eight screens.

Operation complete.
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Operation

Starting Memory Sampling
1. Press START once.

On a DX with advanced security (/AS1 option; release number 4 or later) display

the start recording screen’. With START selected, press DISP/ENTER once.
Memory sampling starts.
This is because the Batch function is enabled upon shipment from the factory.

sl '
% |]|]|:> ] Memory sampling progres

Recording data | DISP: Display data
EVENT: Event data

*

GROLP 1 e , =
i ooz b 0 IEEEsin (SR

Inin/diu

START key

Operation complete.

Stopping Memory Sampling
1. Press STOP once.

GROLP 1 = _
2605/12/81 82:09:48 DIsP I 32nin
2ninfdiy

LH
A ° Display the confirmation
Eoier [ Henory Cancel window.

19:22 19125 12 193 ] Grl

2. Select Mem+Math or Memory using the left and right arrow keys.

19018

Memory: Stops memory sampling.
Mem+Math:  Stops memory sampling and computation (option).

On models without the computation function (option), the confirmation message
“Do you want to stop data storage?” appears. Select Yes.

3. Press DISP/ENTER once.

== o
i Limed 7
Stop memory sampling.

Operation complete.
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Operation

Switching the Trend Display, Digital Display, and Bar Graph Display
1. Press DISP/ENTER once to show the display selection menu.

Left arrow key

Up arrow key

1

()
D - - D *Rightarrowkey
E : | DISP/ENTER key

|
L Down arrow key

N

Press the down arrow key to select TREND, DIGITAL, or BAR.

3. Press the right arrow key once to display the sub menu. To close the sub menu
that you opened, press the left arrow key.

4. Press the down arrow key to select the group.

GROLP 1 P= , =

2008/12/81 11:83:35 o I i (S)ER o)
0

79.4

C

224.2
L/H

3 Select DIGITAL > GROUP 1.

£35 DIGITAL »

9122 19126 19: 19134 fEx) e

5. Press DISP/ENTER once to show the operation display of the selected group. To
close the menu without switching the display, press ESC.

Group number

GROLP 1 = : =
2005/12/01 B2:09:18 oise NN 2ein (O] =)

°C
74- 90— Digital display

2 L/H

218. 6

Press the down arrow key when the trend, digital, or bar graph is displayed to switch the
display in the order trend, digital, bar graph, trend, and so on. Press the up arrow key

to switch the display in reverse order. Press the right arrow key or the left arrow key to
switch the group.

Operation complete.
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Operation

Writing the Message “START”
Registering the Word “START” in Message Number 1

On a DX with advanced security (/AS1 option; release number 4 or later), this operation
is only available when memory sampling is stopped.

1. Press MENU (to switch to setting mode), and select the Menu tab > Message,
Comment > Message > DISP/ENTER.

2. Press 1-10 soft key.

The message, “Message numbers 1-10 can also be used for free message” appears. Press
DISP/ENTER.

3. Press the down arrow key. With message 1 selected, press the Input soft key.
Enter “START”.

Hessage

Message No. 1-18
Characters |
I L —
§ & — Show the message
4 registration window.
5
6
7
8
9
18
Space | Dl Bs Ins | Avarl
Select the digit: Left and right arrow keys
Enter characters: Character/Number input keys

Delete a character:  Del soft key or Bs soft key
Cancel the setting:  Press ESC before pressing DISP/ENTER.

For the input procedure, see “Entering Values and Characters” on page 16.

4. Press DISP/ENTER.
SN L/an n2:8:40 D e (O

Hessage

Hessage No.

Characters
START

= (0 00 —d O U1 B L3 DD

=

1-18 11-28 21-30 31-48 41-50 51-60  |Next 1/2

5. Press ESC three times or MENU twice to return to the operation mode screen.
On a DX with advanced security (/AS1 option; release number 4 or later):
Press ESC three times or MENU twice to display a confirmation screen. To return
to the operation mode screen, select Yes, and press DISP/ENTER.

Operation complete.
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Operation

Writing Message Number 1 “START”

This operation can be carried out while memory sampling is in progress. The message is

displayed on the trend display. Show the trend display first.

1. Press FUNC (display the FUNC key menu), press the Message soft key, and
press the 1 - 10 soft key.

GROLP 1 = ,
2085/13/81 82:21:87 Disp N 58nin

Imin/div

o = ———— Show the message
registration window.

1 2 3 4 5 [ Next 1/2

1 soft key

2. Press the 1 soft key.

GROUP 1 & , =
2005/12/01 B2:21:44 o EEEsn (S5

1ninddiv

Shows the message

(time, message, and

message mark).

B2:21 START 4 Also recorded to the
L internal memory.

Operation complete.
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Connecting to an Ethernet Network

Setup Example 9: Monitoring the DX on a PC Browser

In this example, we will connect the PC and the DX via hub in a one-to-one relationship
and display and monitor the DX screen on a browser on the PC.

Ethernet

DX2000

DX

Setup Item Description Number in the Figure
IP address 192.168.1.101 1

Subnet mask 255.255.255.0

Web server function

Monitor from a Web browser on the PC
using operator page.

Access to the DX

Display the Web page and do not set
access privileges.

PC

Setup Item Description Number in the Figure
IP address 192.168.1.100 4

Subnet mask 255.255.255.0

(1) IP Address of the DX
Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic

setting mode).

Select the Menu tab > Communication (Ethernet) > IP address, Host settings.

Basic Setting Hode

Connunication (Ethernet) > IP-address. Host settings

r IP-address
DHCP

Fixed IP-address
IP-address
Subnet mask
Default gateway

192.168. 1.10le- I
255. 255.255. e

Not

[

— Host settings

Host name

Domain nane
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Connecting to an Ethernet Network

(2) Enabling the Web Server Function on the DX
Select the Menu tab > Communication (Ethernet) > Server > Server.

Basic Setting Hode

Conmunication (Ethernet) > Server > Server

Server
FTP | Use |
Web lse @ 2
SNTP Not
Hodbus Not
PLC Comm Not
| Use | Mot |

(3) Display the DX Screen on the PC
Select the Menu tab > Communication (Ethernet) > Web page.

Page type 2
Web page —

On/0ff 0n o

fAccess control 0ff o 3

Connand Not

Operator | Honitor

(4) Save the Settings
1. Press ESC twice to return to the basic setting menu.

2. Press ESC once more.
The window appears for you to confirm the saving of the settings.

3. Select Yes and press DISP/ENTER.

The DX returns to the operation mode screen.

IM 04L42B01-02E
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(5) Setting the PC
Set the IP address and subnet mask on the PC.

2x|
General |
‘f'ou can get IP zettings assigned automatically if your network, supports
this capability. Othenwise, pou need to ask pour network. administratar for
the appropriate P settings.
" Obtain an IP address automatically
—* Usze the following P address:
IP address: 192168 . 1 100 4
Subret mask: 255 . 285 . 255 . O
Default gateveay: I . . .
! Mhtain DNE server address automatically
—* Usze the following DMS server addresses——————————————————
Prefered DMS server: I . . .
Alternate DMNS server: I . . .
Advanced... |
(] I Cancel |

(6) Checking the Connection

Send the command below from the PC and check that a correct response is returned.

Send
>ping 192.168.1.101

Response example
>Reply from 192.168.1.101: bytes=32 time<10ms TTL=255

(7) Displaying the DX Screen on the Browser
1. Start the browser on the PC.
Enter the following URL.
http://192.168.1.101/operator.htm
3. Check that the DX screen appears.

SIS
| &

I8 [us >

| 2088/12/81 B8:15:42 - = Select Grou
AS7d 1 S E

Select Group => =
) | Data Range Search

OTHER
Select Screen => v

A

DISP 1)

< Jewren

v

[Eoone [T e

Operation complete.
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Connecting to an Ethernet Network

Setup Example 10: Automatically Transferring the Measured Data File to an FTP

Server

In this example, we will configure the DX so that the measured data is automatically

transferred to an FTP server on the network when the measured data is automatically

saved to the CF card.

This example assumes that the following network environment is used: DHCP enabled,

automatically obtain the DNS server information, and automatically register the DX host

name to the DNS server. Set the parameters according to your network environment.
Automatic data transfer to an FTP server

DX || FtPserver
[ [

Internal
memory Q CF card

Measurement input -+ ;@

Ethernet

Setup Item Description Number in the Figure
Host name DAQSTATION1 1
Obtain the IP address Obtain automatically (DHCP) 2
Type of data to be transferred  Acquired measured data 3
FTP server Server name  abcdefg.co.jp 4

Port number 21
Login name FTPUSER1
Password al1234

(1) Host Settings and IP Address of the DX
Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic
setting mode). and select the Menu tab > Communication (Ethernet) > IP address,
Host settings.

r IP-address

DHCP | Use |
DN$ accession Use @
Host-name register Use o

2

Automatically obtain the
DNS server information.
Automatically register the
DX host name to the DNS
server.

— Host settinss
Host name [DAGSTATIONL ——1

| Use | Mot |
(2) Data to Be Transferred to the FTP Server
Select the Menu tab > Communication (Ethernet) > FTP client > FTP transfer file.
Etherne

Basic Setting Mode Lin

Comnunication (Ethernet) > FTP client > FTP transfer file

r FIP transfer file

Disp&Event data T - 3
Report off

Snapshot off

r Transfer vait time

Disp&Event data a nin

Report a nin

On 0ff
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(3) Connected setting FTP Server
Select the Menu tab > Communication (Ethernet) > FTP client > FTP connection.

Comnunication (Ethernet) > FTP client > FTP connection

r FIP connection

FTP server name  |abcdefs ® 4
Port nunber 2le

Login name FTPUSERT [

Password ®

Account

PASY node off

Initial path

(4) Save the Settings
Press ESC three times to return to the basic setting menu.

2. Press ESC once more.
The window appears for you to confirm the saving of the settings.

3. Select Yes and press DISP/ENTER.
The DX returns to the operation mode screen.

Operation complete.

Executing a File Transfer Test
1. Press FUNC once to display the FUNC key menu.

2. Press the Next soft key until FTP test is displayed, and then press the FTP test
soft key.

GROLP 1 P : =
2385/12/81 15:47-28 ois> i (O]

1nin/div

FTP test soft key

Hath FTP test Hedia Systen | Network |Favorite

stop eject info info regist 8
3. Press the Primary soft key once. The messages “FTP test is being executed” and

“Execution is complete” are displayed. The test file (FTP_TEST.TXT) is sent to the
FTP server.

Operation complete.
Transferring the Data Files

When you start memory sampling, the measured data file is transferred to the FTP server
when the data is saved to the CF card.
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Using DAQSTANDARD

Displaying the Measured Data on DAQSTANDARD

In this example, we will display the measured data using the software program,
DAQSTANDARD.
1. Insert the CF card containing the measured data file into the PC that has
DAQSTANDARD installed.

2. Start DAQSTANDARD Viewer.

&, Data Viewer
Fle Vew Help

= = A
4 Ve i T e B

T [EEOEE E W2 SR

Ready [T ow [T

3. From the File menu, choose Open.
4. In the Open dialog box, select the desired file, and click Open.
The data is displayed.

5
7}
-
S
o
=
o
=
o
=3
2
=
=]
@

&, Data Viewer
Fle Edit TmeAds Y-ws Miew Window Conved [nfomation Signature Help

|z@E (B e @a awemm Y e
R AR

[B] Display File-Graph[DX-000001]

I EEOEED v e (3T

Ready [T ow [T

Operation complete.
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Installation and Wiring

Installation Location
Install the DX indoors in a location that meets the following conditions.

* Instrumentation Panel
The DX is designed to be installed in an instrumentation panel except for the desktop
type.

* Well-Ventilated Location
To prevent overheating, install the DX in a well-ventilated location. For the panel cut
dimensions when arranging multiple DXs, see the page 51. Follow the panel cut
dimensions providing adequate space between instruments when other instruments
are arranged on the panel. For the desktop type, we recommend that a space of at
least 50 mm be provided around the left, right, and top panels of the DX.

¢ Minimum Mechanical Vibrations
Choose an installation location with the minimum mechanical vibration. Installing the
DX in a location with large mechanical vibration not only causes adverse effects on
the mechanism but also may hinder normal recording.

* Horizontal
Install the DX horizontally (However, the DX can be inclined up to 30 degrees
backwards for panel mounting).

¢ Ambient temperature range between 0 to 50°C

* Ambient humidity between 20 to 80%RH ( However, less than moisture
content of 40°C 80% RH at 40°C or more), No condensation should be
present.

¢ Altitude 2000 m or less

Note

Condensation may occur if the DX is moved to another place where the ambient temperature is
higher, or if the temperature changes rapidly. In addition, measurement errors will result when
using thermocouples. If this happens, let the DX adjust to the new environment for at least one
hour before using it.

Do not install the DX in the following places.

e Outdoors

* In Direct Sunlight or Near Heat Sources
Install the DX in a place with small temperature fluctuations near room temperature
(23°C). Placing the DX in direct sunlight or near heat appliances can cause adverse
effects on the internal circuitry.

¢ Where an Excessive Amount of Soot, Steam, Moisture, Dust, or
Corrosive Gases Are Present
Soot, steam, moisture, dust, and corrosive gases will adversely affect the DX. Avoid
such locations.

* Near Strong Magnetic Field Sources
Do not bring magnets or instruments that produce electromagnetic fields close to the
DX. Operating the DX in strong magnetic fields can cause errors in the measurements.

¢ Where the Viewing of the Display Is Poor
The DX uses a TFT color LCD for the display. Therefore, viewing of the display from
an extreme angle is difficult. Install the DX so that the user can view the display from
the front.
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Installation Procedure
Installation Procedure (Panel Mount Type)
Use a steel panel of thickness 2 mm to 26 mm.
1. Insert DX from the front of the panel.
2. Mount the DX to the panel using the mounting brackets that come with the
package as shown in the figure below.

» Use two brackets to support the top and bottom or the left and right sides of
the case (remove the seal that is covering the holes for the mounting brackets
beforehand).

» The proper torque for tightening the mounting screws is 0.7 to 0.9 Nem.

* Mount the DX to the rack according to the procedure below.

* First, attach the two mounting brackets and temporarily fasten the
attachment screws.

* Next, fix the DX in place by tightening the attachment screws with the
appropriate torque. When the DX is approximately perpendicular to the
panel as you fasten the screws, press the mounting bracket against the
case so that they are in contact with each other.

A CAUTION

» Tightening the screws too much can deform the case or damage the bracket.

» Be careful not to insert foreign objects or tools through the holes for the
mounting brackets in the case.

» Make sure the rubber gasket is affixed so that it does not become entangled
between the main unit and the panel. Affixing the gasket incorrectly will result in
failure to achieve sufficient dust and water proof performance.

Correct Incorrect: Gasket entangled
/ /
N Rubber gasket S Rubber gasket
Bezel Bezel
Panel Panel

Panel Mounting Diagram
|Screw temporarily |

5
7}
-
S
o
=
o
=
o
=3
2
=
5
@

Panel

Mounting brackets

DX case

Attachment Panel Mounting Attachment screw
i brackets

l—Torque driver
— (flat blade)

In contact with

Front each other

(The figure shows the case when the mounting brackets
are used on the top and bottom of the case.)

Nofte
To achieve sufficient dust and water proof performance, mount the DX in the middle of the
panel cut out.
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External Dimensions and Panel Cut Dimensions
Panel Mount Type

Panel cut dimensions Unit: mm (approx. inch)
360 min Unless otherwise specified, tolerance

(14.17) is 3% (however, tolerance is £0.3 mm
when below 10 mm).
280.2 (11.03) =
ATy oS
- O ~
@ =
NE
2813
(11.06) (When the /H2 or /PM1
option is installed)
226 (8.90) max,
295.2 (11.62) 27.3 221.6 (8.72) (Dimensions before attaching
288 (11.33) (1.07 168 (6.61 the mounting bracket)
180 (7.09) _2-26 < E
|[Allowablepanel(hickness} o, Q
| . ]
5 g 3
S o Y (e=) N
~ | © (=) S
o o N ﬂ 8
2 |0 NelE ‘
|| l54.6 32.1 o/
o<1 ~ o
108 | (2.15) = (Dimensions after attaching
(4.25) the mounting bracket)

Desktop Type (/H5[ ] Option)
282.5 (11.12)

Unit: mm (approx. inch)

! Unless otherwise specified, tolerance
ﬁ% is £3% (however, tolerance is £0.3 mm
when below 10 mm).

1®) )

(When the /H2 or /PM1
/_ option is installed)

253.3 (9.97) max.

289.6 (11.40) 245.1 (9.65)

40
(1.57)

/ D §

289.7 (11.41)
352.8 (13.89)
287.8 (11.33)

5 T
(0.98)
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Input Signal Wiring

AN

To prevent electric shock while wiring, ensure that the power supply source is
turned OFF.

CAUTION

If a strong tension is applied to the cable wired to the DX, the terminals of the DX

and/or the cable can be damaged. In order to prevent tension from being applied

directly on the terminals, fasten all wiring cables to the rear of the mounting panel.

To prevent fire, use signal wires having a temperature rating of 70°C or more.

Do not apply a voltage exceeding the following value to the input terminals.

Otherwise, damage to the DX may result.

* Maximum input voltage: +60 VDC

* Maximum common mode voltage: 60 VDC (under measurement category Il
conditions)

Precautions to Be Taken While Wiring
Take the following precautions when wring the input signal cables.

When using a screw terminal, we recommend that you use a crimp-on lug
with an insulation sleeve (designed for 4-mm screws).

@@—Crimp-on lug with insulation sleeves (for 4 mm screws)

When using a clamp terminal (/H2), we recommend that you use the

following kind of cable:

+ Conductive cross-sectional area: 0.08 mm? to 1.5 mm? (AWG 28 to 16)

Length of the stripped section of the wire: Approx. 7 mm

Take measures to prevent noise from entering the measurement circuit.
Move the measurement circuit away from the power cable (power circuit) and ground circuit.
It is desirable that the object being measured does not generate noise. However, if
this is unavoidable, isolate the measurement circuit from the object. Also, ground the
object being measured.

Shielded wires should be used to minimize noise caused by electrostatic induction.
Connect the shield to the ground terminal of the DX as necessary (make sure you are
not grounding at two points).

To minimize noise caused by electromagnetic induction, twist the measurement circuit
wires at short, equal intervals.

Make sure to earth ground the protective ground terminal through minimum resistance
(less than 100 Q).

5
7}
-
S
o
=
o
=
o
=3
2
=
5
@

Do not allow static electricity to be applied to the terminals.

When wiring the terminals, remove static electricity so that static electricity is not applied.
If static electricity or similar high-voltage transient noise is applied to the signal line,
the system may break.

When using internal reference junction compensation on the thermocouple
input, take measures to stabilize the temperature at the input terminal.

Always use the terminal cover.

Do not use thick wires which may cause large heat dissipation (cross sectional area of
0.5 mm? or less recommended).

Make sure that the ambient temperature remains reasonably stable. Large
temperature fluctuations can occur if a nearby fan turns ON or OFF.

Connecting the input wires in parallel with other devices can cause signal
degradation, affecting all connected devices. If you need to make a parallel
connection, then

Turn the burnout detection function OFF.

Ground the instruments to the same point.

Do not turn ON or OFF another instrument during operation. This can have adverse
effects on the other instruments.

RTDs cannot be wired in parallel.
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Wiring Procedure

A terminal cover is screwed in place on the measuring input terminal block on the rear
panel. A label indicating the terminal arrangement is affixed to the cover.

1. Turn OFF the DX and remove the terminal cover.

2. Connect the signal wires to the terminals.

Recommended torque for
tightening the screws

Screw terminals

0.9t0 1.0 Nem

Clampted terminals

0.22 t0 0.25 N*m

3. Replace the terminal cover and fasten it with screws. The proper torque for
tightening the screws is 0.6 N-m.

Note

Input signal wires of diameter less than or equal to 0.3 mm may not be secured firmly for
clamped terminals (/H2). Fold over the conducting section of the wire, for example, to make
sure that the wire is securely connected to the clamped terminal.

Arrangement of the Input Terminals

Input terminal block 3 —

- Input terminal block 1

Input terminal block 4 —-Hﬁ ] { 0+—- Input terminal block 2
&
Input | Channel Assignments by Model
block | DX2004 DX2008 | DX2010 | DX2020 | DX2030 | DX2040 | DX2048
1 1-4 1-4 1-10 1-10 1-10 1-10 1-12
2 5-8 11-20 11-20 11-20 13-24
3 21-30 21-30 25-36
4 31-40 37-48
Screw terminal Clamp terminal
CH4 CH2
CH3 CH1 CH3 CH1
Input terminal block 1 of b HibA
the DX2004 and DX2008 %%%% n | @E HA
B -/B CH4 CH2

Input terminal block 1 of
the DX2010, DX2020,
DX2030, and DX2040

Input terminal block 1 of
the DX2048

CH10 CH8 CH6 CH4 CH2

CH9 CH7 CH5 CH3 CH1

DDDDDDDDDE | b
DD |+
FDDDDDADDDD |8

CH12 CH10 CH8 CH6 CH4 CH2

H11 CH9 CH7 CH5 CH3 CH1

PRiP@RRRRRRD

2| 1o
DR )| +ia
PERRRRRRRRR |-

CH11 CH9

CH7

1| O

CH3 CH1

[

g

CH12 CH10

I
TE===\S

CH8 C

CH4 CH2
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Wiring Screw Terminals

DC voltage input/DI (ON/OFF) input TC input
Compensating leadwire
+ + l
+
DC voltage input [
RTD input DC current input

b
A +
+
B A DC current input

Shunt resistor
Example: For 4 to 20 mA input, use a
shunt resistor of 250 Q + 0.1%.

Lead wire resistance per wire of
10 Q or less. Make the resistance
of the three wires equal.

Wiring Clamped Terminals

CAUTION

As of August, 2007, the direction of the terminal blocks for the clamp input terminals
(/H2 option) has changed. To use clamp input terminal blocks wired for use with
previous YOKOGAWA recorders, rewire them to match the DX.

5
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Remove the terminal block Connect the wires Connect the terminal block

Hold both ends of the terminal Hold both ends of the terminal block,
block and pull straight. align with the connector on the DX
side, and push the terminal block into
the connector.

Recommended X F|at-b|§lqe
length of stripped ~__ @R N screwdriver
wire: 7. mm %

Q\
Recommended wire size \

‘©

0.08 to 1.5 mm? (AWG 28 to 16)

Input signal wire

First, loosen the screw at the front using a flat-blade
screwdriver. Insert the input signal wire into the slit on the

left side of the terminal block, and fasten the screw at the front.

Nofte

RTD input terminals A and B are isolated on each channel. Terminal b is shorted internally
across all channels. However, terminal b is also isolated on each channel on models with the
/N1 option (Cu10, Cu25 RTD input/3 leg isolated RTD) and /N2 option (3 leg isolated RTD).

S
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Optional Terminal Wiring

A

To prevent electric shock while wiring, ensure that the power supply source is
turned OFF.

If a voltage of more than 30 VAC or 60 VDC is to be applied to the output terminals,
use ring-tongue crimp-on lugs with insulation sleeves on all terminals to prevent the
wires from slipping out when the screws become loose. Furthermore, use double-
insulated wires (dielectric strength of 3000 VAC or more) for the signal wires on which
a voltage of more than 30 VAC or 60 VDC is to be applied. For all other wires, use
basic insulated wires (dielectric strength of 1500 VAC). To prevent electric shock,
attach the terminal cover after wiring and make sure not to touch the terminals.

CAUTION

Use the following circuit voltage for the connection to the alarm/FAlL/status
output terminal.
*  When the connection is to Mains Circuits (primary AC power source circuits):
150 V or less
* When the connection is to circuits derived from Mains Circuits (secondary
circuits): 250 V or less
(Mains Circuits voltage is less than 300 V, and connection must be used by
isolation transformer.)
To prevent fire, use signal wires having a temperature rating of 70°C or more.
If a strong tension is applied to the cable wired to the DX, the terminals of the DX
and/or the cable can be damaged. In order to prevent tension from being applied
directly on the terminals, fasten all wiring cables to the rear of the mounting panel.
Do not short the transmitter power supply output terminal or apply external
voltage to it. If you do, the DX may malfunction.
When using the transmitter power supply output terminal, do not use current that
exceeds the maximum output current (25 mADC). If you do, the DX may malfunction.
Do not short the VIDEO OUT terminal or apply external voltage to it. If you do,
the DX may malfunction.

Nofte
For remote control wiring, use shielded wires to reduce noise. Connect the shield to the
functional ground terminal or the ground terminal of the DX.

Precautions to Be Taken While Wiring
It is recommended that crimp-on lug with insulation sleeves (designed
for 4-mm screws) be used when connecting wires to the optional input
terminals.

@@_Crimp-on lug with insulation sleeves (for 4-mm screws)

Wiring Procedure
As shown in the figure on next page, the optional terminal block is located on the rear panel. The

optional terminal block is provided on the DX when an option that requires input/output is installed
such as the alarm output relay (/A[ ] option), FAIL/status output relay (/F1 or /F2 option), and
remote control function (/R1 option), etc. A terminal cover is screwed in place on the measuring
input terminal block. A label indicating the terminal arrangement is affixed to the cover.

1.
2.

3.

Turn OFF the DX and remove the terminal cover.

Connect the signal wires to the terminals. The recommended torque for tightening
the screws is 0.9 to 1.0 Nem

Replace the terminal cover and fasten it with screws. The proper torque for
tightening the screws is 0.6 Nem.
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Arrangement of the Optional Terminals

PEHY
o oY W ]
Optional terminal block 3—-t‘ ] { o+—- Optional terminal block 1
&
o oY O |
Optional terminal block 4—-&‘ ] { Of—- Optional terminal block 2
o
@ o] [ & koA
{ I [ )
o o
O Lo TR ad]
I I |

| Description of Symbols |

Symbols such as “NC”: Terminal functions

Alarm output, FAIL, Status Remote control input
NC: Normally closed 1 to 8: Terminal number

Pulse input
Hand L: See page 61.

Transmitter power supply
+and -: See page 61.

C: Common C: Common
NO: Normally opened See page 61.
See page 61.

Aterminal that is not used. (With a screw)
|:| Aterminal that is not used. (Without screw)

Options That Use Option Terminal Block 1 Only

These options can come with /TPS4 or /TPS8.

In that case, the option terminal block 4, or option terminal blocks 3 and 4 are installed. z
For the terminal arrangement for /TPS4 and /TPS8, see page 57. :=’
g.
=
[V
=3
o
IA2 IA3 s
Alarm Alarm Alarm g
output output ou}\put Q
r A}
02 01 04 0302 01 06 0504 0302 01
& @R [@Ine] |ne & GOINC|  [Nc|Nc| [NC NC| Inc|nc| |Nc|Nc| |Nc
@ @@ @c| |c & @ c| [cle| |c €l lc|c| |clc| |c
@ @@ [@no| |no &) |®@Ino| |Nono| [no NO|  INo|No| [No|No| [NO
IA1/R1 IA2/R1 IA3/R1
Alarm Remote Alarm Remote Alarm Remote
output control output control output control
input input P A N input
02 01— 04 0302 01— 06 0504 0302 01—
& @@ [@Inc] [nc[6 |3 ol @ @Ine] [nc|ne] [ncle 3 c| INC| Inc|nc| |Nc|nc| |Nc|6 |3 ¢
@@@@c cl7laf7] & @c| [c|c cl7|afq] & |clc| |elc| |c|7|a],
&) @R (@Ivo| [nols 5[5 @ @|No| |NojNo| [No|8 |5 [, | NO [Nono| |nojno| |Nos |5 |,
IR1 /A1 IF1 /A2 |[F1
Remote Alarm Alarm
control Status output Status output
input  FAIL — FAIL T
— 02 01 04 0302 01
6|3[c| N [Nc[3®)| (P)INc| |nC NC| Inc|nc| |Nc|Nc| [Nc
747 I [c|@ [@c| |c Cl lclec| |[clc]| |c
8|55 N9 [NO|@D)| [@D[No| [NO NO|  Ino[No| |No[NO| [NO

(To next page)

IM 04L42B01-02E

57




Installation and Wiring

(From previous page)

IF1 /A1 [F1 /R1 /A2 I[F1 /R1
Aleirmt Remtotle Alatrmt Remtotle
Status outpu contro Status outpu contro
FalL Sttus FAIL ——  nput  FAlL ———A———— input
l 02 01— l 04 0302 01—

d [ (Y1159 I =) 9 I 59 NCl  Inc|GD] (@Inc| |Nc|e |3 [c] [NC| [Nc|nc| [Nc|nc| [nc|e |3 [¢
‘e @ @ eI Tel@l [@c| [cl7lel+] [l [cle| [ele] [cl7le[s
e I V10159 B =) 69 I 59 NOl INo[@®)| (@)INo| [noj8 |5 (5] [NO |nojno| [No|No| [No|8 |5 |5
IF1 /R1 IA1 [PM1 IA2 [PMA
Remote Alarm Remote Alarm Remote
Status control output ﬁ’#és.ﬁ control output ﬁ’#g)slﬁ control
FAIL input — 0 input — —A— input
— 2 01 g g ¢~~~ 04 0302 01 G, ¢
N[ nel@] (@@ (@6 (3] @ [@Ine] Ine] [H[u]u[slc] N[ Inc|ne] [ne] [u[u]n]s g
cl cl@ @@ @ 7]a71 @ @c| [c| [clelc]alfz] [ [cle| [c| [cc|c]aly
N Inol@ (@I [@s |5 ] [@ [@no| [no 55| N [no|No| [No 2
/A1 [F1 /PM1 /PM1 [F1 /PM1
Status Alarm Pulse Remote Pulse Remote Pulse Remote
output input  control input  control Status input  control
FAIL — —A— input A input FAIL A input
02 01 87 67 87 6 8 7 6
NC| Inc|nc| |Nc| |H|H|H|3[¢ HIH|H[3[c] IN¢] [Nc|@®) (@D [H|H|H|3 [
Cl lcle| [c| |L|L|L|afy Llicfefafq] (G [c(@ (@ |c|c|c|al;y
NO|  INo[No| [no 5[, 505 N9 no@) (6D )
[TPS4
Transmitter power supply
/_/%
@ 4]+
ITPS8
05 Transmitter power supply

/_/%

S @ T

Transmitter power supply

/_/%

@++++
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| Options That Use Option Terminal Blocks 1 and 2 |

/A3 IF1
Status

— | | IO

Nl vel@] @@

@
B L @ @@%

NO
NG (R
Alarm
output
r A A}
16 15 14 13 12 1"

NC| Inc|nc| |Nc|ne|  [Ne

c clc cle c

NO|  Ino|no| |No|NO|  [NO

/A3 /PM1
Pulse  Remote
input control
—"— input
8 7 6
HIH|H|3 ¢
L|L|L|4]4
5|2
Alarm
output
r A A}
16 15 14 13 12 11

NC| Inc|nc| |Nc|ne|  [Ne

c clc cle c

NO|  Ino|no| |No|NO|  [NO

IA4
Alarm
output
r A A}
06 05 04 03 02 01

NCl  Inc|nc| |Nc|ne|  [Ne

c clc cle c

NO|  Ino|no| |No|NO|  [NO

Alarm

output
r A hY
16 15 14 13 12 "

NC| Inc|nc| |Nc|nc|  [Ne

c clc clc c

NO|  Ino|no| |No|NO|  [NO

These options can come with /TPS4 or /TPS8.

®

®

®

®

/A3 IF1 IR1
Remote
Status control
FAIL input
P —
N Inel@) @@ [ @e (3 [c]|D
¢l cl® DB @747
Ol Inoled) | @@ (@) |5 2
Alarm
ou/t\put
/16 15 14 13 12 11\

NC| Inc|nc| |Nc|ne|  [Ne
c clc clc c
NO| |no[no| |No|No| [NO

-

/A3 /F1 /PM1

Pulse  Remote
EAIL Status input c_ontr(t)l
— inpu
v l 8 7 6
Nl Tnel@] @[ [v[w[#[sTc] @
°l lele® 1@ [Lir||afq]
Ol noj@) | @ 52|
Alarm o
output
r A Al
16 15 14 13 12 1" -
S
NC|  Inc|Ne| |Nc|Nc|  [Ne _@ g
€l lclc| |c|c c ] 3
NO ] S
NO|NO NO|NO NO :
b ]
o
s
/A4 IR1 =
Alarm Remote «Q
output control
P A N input
06 05 04 03 02 01

NC| Inc|nc| |Nc|nc| |Nc|6 |3 [¢
€l [clc| [c|c| |c|7|a[;
2

O]

NO|  Ino|no| |No|No|  [NO| 8

Alarm
output
r A hY
16 15 14 13 12 1"
NC
NC|NC NC|NC NC @

c clc clc c
NO|  Ino|no| |No|NO|  [NO

In that case, the option terminal block 4, or option terminal blocks 3 and 4 are installed.

For the terminal arrangement for /TPS4 and /TPS8, see page 57.
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Installation and Wiring

| Options That Use Option Terminal Blocks 1, 2, and 3

/A4 IF1
Alarm
output Status
. \ FAIL
26 2524 2322 21 1
® N INc|nc| |Nc|Nc| [NC NCI Il |0 | O)
€| |ele| |ele| e °lc® @@ @
NO| Ino|no| [no[no| [NO NOI Ino|®)  [DGD (&)
Alarm
output
A
r hY
16 1514 1312 M
NG| Inc|ne|  [Nc|Nc|  |Ne ®
|l |clc| |e|e| |c
NO| Ino|No| |No|NO| |NO
/A4 /F1 IR1
Alarm
output Status S:(e)m(r)é?
Ve A N FAIL input
26 2524 2322 21 v l
@ [N |nc|nc| |Nc|Nc| |Nc NI INnc|® |60 ()6 3[c|@

c clc clc c ¢ c® @D 7|41

NO|  Ino[no| [No[NO| [NO NOl Ino|@)  |®GD (@) s |5 (5
Alarm T
output

A
r hY
16 1514 1312 N
NGl Inc|ne|  [Nc|Nc|  |Ne 1®
€l lcle| |c|c| |c |
NO|  Ino|no| [No|no| |NO |
/A4 |PM1
Alarm
Pulse
. ou}Put . input
26 2524 2322 21 s 7 6 ——
@ [N¢| |nc|nc| |NcNc| |Nc HIH|H|3 ] (@D
€| lclc| |c|c| |c Lic|L|4fq]

NO|  |No|No| [No[no| |NO 5[5
Alarm T
output

A
r N\
16 1514 1312 M
NG| Inc|nc| [Nc|nc|  |ne @
|l |clc| |e|e| |c |
NO|  Ino|no| [No|No| |NO ]
/A4 [F1 PM1
ﬁlq{rmt Pulse Remote
, utpu § FAIL Status input c_ontrtt)l
26 2524 2322 21 v l % 7 6~
B N |Nc|nc| |Nc|Nc| [nc NI Inci@d [@) [H[H[H[3[c] @
€l lele| |clc]| |¢c | |cl®@ @ [c|c|L|afq]

NO|  |No|No| |no[No| [NO NOl Ino[gd)| (@) 5[5
Alarm T
output

A
r hY
16 1514 1312 M
NG| Inc|ne| [Nc|nc|  |Ne 1@
These options can come with /TPS4. c clc cle P o
In that case, the option terminal block 4 is installed. |
For the terminal arrangement for /TPS4, see page 57. NO| Ino|No| |No|NO| |NO
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Installation and Wiring

| Options That Use Option Terminal Blocks 1, 2, 3, and 4 |

IA5
Alarm Alarm
output output
r A N\ r A N\
26 2524 2322 21 06 0504 0302 01
® NC| Inc|nc| |Nc|nc|  |Ne NC| Inc|nc| |Nc|ne|  |Ne ©)
c cle| lcle| |c c cle| lcle| |c
NO|  Inolno| |No|NO| [NO NO|  Ino|no| |No|no| [NO
Alarm Alarm
output output
r A N\ r A N\
36 3534 3332 31 6 1514 1312 11
@ NCl Inc|nc| |Nc|nc|  |Ne NC| Inc|nc| |Nc|nc|  |Ne )
c cle| lcle| |c c cle| lcle| |c
NO|  Inolno| |No|NO| [NO NO|  Ino|no| |No|No| [NO
/A5 IR1
Alarm Alarm Remote
output output control
r A N Is A N input
26 2524 2322 21 06 0504 0302 01
® NC| Inc|nc| [Nc|ne| [Ne NCl  Inc|nc| [Nc|ne| |Nc|6 |3
cl ®
€| lcic| |c|c| |c €l lclc| |clc| |c|7]a[q
NO|  Ino[No| |no[NO| [NO NO|  INo|No| [No[No| [NO|8 |5 [,
Alarm Alarm
output output
r A N\ r A Y
36 3534 3332 31 16 1514 1312 11

NC| Inc|nc| |Nc|nc|  |Ne

NO|  Ino|no| |No|NO| [NO NO|  Ino|no| |No|No| [NO

F2

Alarm
Status output

FAIL
26 25 24 23 22 21 l 04 03 02 01

/
® NC| Inc|nc| |Nc|nc|  |Ne ﬂ"c Nc|Nc| |Nc|nc|  [Ne

Alarm
output
N

5
7}
-
S
o
=
o
=
o
=3
2
=
5
@

c clc clc c
NO|  Inolno| |No|NO| [NO

Alarm
output
A

NO|  Ino|No| |No|NO| [NO

Alarm
output
A

r
36 35 34 33 32 31 16 15 14 13 12 1"

NC| Inc|nc| |Nc|nc|  |Ne

NO|  Ino|no| |No|No| [NO NO|  Ino|no| |No|No| [NO

LI 1] L1 LI 1]
®

IF2 |R1
Alarm Alarm Remote
output Status output control
s % \ FAIL ———"———  input
26 25 24 23 22 21 04 03 02 01—

NO|  Ino[No| |no[NO| [NO NO|  |No|No| [No|no| [No|8 |5 [,

Alarm Alarm
output output
A A

36 35 34 33 32 31 16 15 14 13 12 1"

NC| Inc|nc| |Nc|nc|  |Ne
c cle clc c
NO|  Ino|no| |No|No| [NO

NO|  Ino|no| |No|NO| [NO

® N9 |nc|nc| |Nc|nc| |Nc NG| INc|Nc| [nc|nc| [ncls |3 [c] D
€l lc|e| |clc]| |c €l lclc| |c|c| |c|7]a]y

L]
®
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Installation and Wiring

NC
c
NO

Alarm Output Terminal (/A1, /A2, /A3, /A4, and /A5), FAIL Output Terminal, and
Status Output Terminal (/F1 and /F2)

Output format: Relay contact FAIL
Contact rating: 250 VAC (50/60 Hz)/3 A, output N{}; Nlc Nlo é/Nlc Nlo 6/,}
250 VDC/0.1 A (for resistor load) (IF1, [F2) During normal  When a failure  When power is
Withstand voltage: 1600 VAC at 50/60 Hz for one ’ operation oceurs turned OFF
minute (between output terminals | Other |/ N | | /
and the ground terminal) output NO C NC NO C NC. NOCNC
(/F1 /F2) During normal ~ When specified  When power is|
’ operation status occurs turned OFF

Remote Control Input Terminal (/R1)

* Relay contact input
(voltage-free contact)
Contact closed at 200 Q or less
Contact open at 100 kQ or greater

—&)6 3 c
7 O— 4 O— 1
)8 5 2

* Transistor input (open collector)

ON voltage: 0.5V or less (30 mADC)
Leakage current when turned OFF:
0.25 mA or less

6 3 C
7 4 1
8 5 2

-

~8

3

Internal circuit

v Input format:
Photocoupler isolation
Shared common (C)

Allowable input voltage:
5VDC

Withstand voltage: 1000 VDC for one minute between input terminals and the ground terminal

Pulse Input Terminal (/PM1)

* Relay contact input
(voltage-free contact)
Contact closed at 200 Q or less
Contact open at 100 kQ or greater

*Transistor input (open collector)

ON voltage: 0.5V or less (30 mADC)
Leakage current when turned OFF:
0.25 mAor less

5V Input format:

Internal circuit

Photocoupler isolation
Shared common (L)
Allowable input voltage:

f@:

7 6 8 7 6
H H H H H
LT4_%L {%L {%L {%L

H 30 VDC

AR

Withstand voltage: 1000 VDC for one minute between input terminals and the ground terminal

24 VDC Transmitter Power Supply Output Terminal (/TPS4 and /TPS8)

Connect the DX to the transmitter as shown below.

DX

Current
—_—

Transmitter power
supply output terminal

Input terminal

Serial Interface

Note
To reduce noise, use a shielded cable for wiring.
Connect the shield to the functional ground
terminal or the ground terminal of the DX.

Transmitter

Shunt resistor: 250 Q

Connecting to the RS-232 Connector (/C2)

12345 2 RD (Received Data):
VL 3 SD (Send Data):
TrY 5 SG (Signal Ground):
@ ° 0 @ 7 RS (Request to Send):
é ’7 L \9 8 CS (Clear to Send):
(male)

Received data from the PC. Input signal to the DX.

Transmitted data to the PC. Output signal from the DX.

Signal ground.

Handshaking signal when receiving data from the PC. Output signal
from the DX.

Handshaking signal when transmitting data to the PC. Input signal to
the DX.

*Pins 1, 4, 6, and 9 are not used.

Connecting to the PROFIBUS-DP Connector (/CP1)

54321 3 RxD/TxD-P:
| | 4 CNTR-P:
(S %, i b4 oi g 2) 5 DGND:
@ 00 @ 6 VP +5V:
8 RxD/TxD-N:
T 1T .
9 876
(female)

Positive data input/output.

RTS (needed when using a repeater).
Ground.

+5 V.

Negative data input/output.

Pins 1, 2, 7, and 9 are not used.
** The DX does not have a built-in terminator. If you need to terminate the cable at the
DX, use a terminated connector.
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Installation and Wiring

Connecting to the RS-422/485 (/C3)
Four-wire system Two-wire system —_l

o|lo|o|ao o o FG (Frame Ground) Frame ground of the DX.
SG (Signal Ground) Signal ground.

o o :I
@ @ @ @ @ @ @ @ @ SDB (Send Data B) Send data B (+).
SDA (Send Data A) Send data A (-).
E E @ E RDB (Received Data B) Receive data B (+).
— 1 n RDA (Received Data A) Receive data A (-).
FG SG SDB SDA RDB RDA FG SG SDB SDA RDB RDA

|

Electric ' . Electric
potential <— Shield potential
of the shield of the shield

O O 0

Recommended length of stripped wire: 9 mm. Recommended tightening torque: 0.4-0.5 Nem.

Cable
There are two types of cables available, the four-wire cable and the two-wire cable (used only for the Modbus protocol).
The cable should meet the following specifications.
* Type: Shielded twisted pair cable: 3 pairs 24 AWG or more (four-wire),
2 pair 24 AWG or more (two-wire)
« Characteristic impedance: 100 Q
» Capacitance: 50 pF/m
« Total cable length: Up to 1.2 km

Connecting to the VGA Connector (/D5)

A CAUTION

» Connect the cable after turning OFF the DX and the monitor.
» Do not short the VIDEO OUT terminal or apply external voltage to it. If you do,
the DX may malfunction.

5
7}
-
S
o
=
o
=
o
=3
2
=
5
@

VGA Output Terminal
VIDEO OUT(VGA) A

)
00000
cooo0

i —/——"nJ

The DX display can be output to a monitor through the RGB output. Connectable
monitors are VGA monitors or multi-sync monitors capable of displaying VGA.

Specifications of the VGA Output Terminal

Pin No. Signal Name Specifications
1 Red 0.7 Vp-p
2 Green 0.7 Vp-p
5 1 3 Blue 0.7 Vp-p
4 -
boood ° _
10 000 Off6; G
(ONONONON® 8 &ND
9 -
15 11 10 GND
1 -
D-Sub 15-pin receptacle 12 _
13 Horizontal sync Approx. 31.5 kHz, TTL
signal negative logic
14 Vertical sync signal  Approx. 60 Hz, TTL

negative logic
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Installation and Wiring

Connecting to the Monitor
1. Turn OFF the DX and the monitor.

2. Connect the DX and the monitor using an analog RGB cable.
3. Turn ON the power to both the DX and the monitor. The DX screen is displayed
on the monitor.
Note
*  When the DX is turned ON, a VGA signal is always output from the VIDEO OUT terminal.
» The monitor screen may flicker if the DX or another instrument is brought close to the
monitor.
* The edge of the screen may drop out depending on the monitor type.

Connecting to the USB Port (/USB1)
The USB port complies with Rev. 1.1.

Front Rear

USB port

Connecting to the Ethernet Port
Ethernet port

Indicator CAUTION

Do not connect an Ethernet cable whose plug does
not comply with FCC specifications. If you do, the

DX may malfunction.
]

Checking the Connection/Communication Status
You can check the connection status of the Ethernet interface with the indicators that are

located above the Ethernet connector of the DX.

Indicator Connection Status of the Ethernet Interface
llluminated (green) The Ethernet interface is electrically connected.
Blinking (red) Transmitting data.

Off The Ethernet interface is not electrically connected.

Checking the Connection on the DX Display
¢ Checking the Connection at the status indication section of the DX display
You can check the connection status of the Ethernet interface on the Ethernet Link
indicator located on the right side of the status display section of the basic setting
mode display. The basic setting menu appears by pressing MENU to display the
setting menu followed by FUNC for approximately 3 s.

¢ Checking the Connection Status in the Display Section in the Upper

Right Corner of the Communication Log Display of the DX
You can check the connection status of the Ethernet interface on the Link indicator on
the display section in the upper right corner of the communication log display.

Indicator Connection Status of the Ethernet Interface
llluminated (green) The Ethernet interface is electrically connected.
Off The Ethernet interface is not electrically connected.
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Installation and Wiring

Power Supply Wiring
Panel Mount Type, or Desktop Type with /P1 Option (Models with /H5 and /P1 Options)
Precautions to Be Taken While Wiring the Power Supply
Make sure to follow the warnings below when wiring the power supply. To prevent electric
shock and damage to the DX, observe the following warnings.

A | WARNING

» To prevent electric shock when wiring, ensure the main power supply is turned OFF.

» To prevent the possibility of fire, use 600 V PVC insulated wire (AWG20 to 16) or
an equivalent wire for power wiring.

* Make sure to earth ground the protective earth terminal through a grounding
resistance less than 100 Q before turning ON the power.

» Use crimp-on lug with insulation sleeves (for 4-mm screws) for power supply
wires and protective grounding wires.

» To prevent electric shock, make sure to close the transparent cover for the
power supply wires.

» For safety, provide a double-pole switch in an easily operable location near the
DX to disconnect the DX from the main power supply. Put an indication on this
switch as the breaker on the power supply line for the DX and indications of ON and
OFF.

Switch specifications
Steady-state current rating: 1 A or more (other than /P1), 3 A or more (/P1).
Inrush current rating: 60 A or more (other than /P1), 70 A or more (/P1).
Use a switch complies with IEC60947-1, 3.

» Connect a fuse (between 2 A and 15 A) to the power line. Use a fuse approved §
by CSA (for the use in North America) or VDE (for the use in Europe). 5=>'
» Do not add a switch or fuse to the ground line. %.
=
S
Use a power supply that meets the following conditions: o
Item Other than /P1 /P1 5
Rated supply voltage 100 to 240 VAC 24 VDC/AC ’g
Allowable power supply voltage range 90 to 132, 180 to 264 VAC 21.6V to 26.4 VDC/AC
Rated power supply frequency 50/60 Hz 50/60 Hz (for AC)
Allowable power supply frequency range  50/60 Hz + 2% 50/60 Hz + 2% (for AC)
Maximum power consumption 74 VA (100 V)/100 VA (240 V) 45 VA (for DC), 70VA (for AC)
Nofte

Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on
the measurement accuracy.

Wiring Procedure
1. Turn OFF the power to the DX and open the transparent power terminal cover.

2. Wire the power cord and the protective ground cord to the power supply terminals.
Use ring-tongue crimp-on lugs (designed for 4 mm screws). The proper torque for

tightening the screw is 1.4 to 1.5 Nem (12.4 to 13.2 inchelbs).

Other than /P1 IP1
(24 VDC/AC power supply)
100-240V AC~ 24VDC I 28\A MAX
50/60Hz 60VA MAX 24V AC ~50/60Hz 45 MAX
N & B
Note

Do not wire the protective grounding
cord to the functional ground terminal.

3. Replace the power terminal cover, and fasten it with screws.

IM 04L42B01-02E 65



Installation and Wiring

Desktop Type (/H5[ ] Option)

Precautions to Be Taken While Connecting the Power Supply

Make sure to follow the warnings below when connecting the power supply. To prevent
electric shock and damage to the DX, observe the following warnings.

A

Before connecting the power cord, ensure that the source voltage matches the
rated supply voltage of the DX and that it is within the maximum rated voltage
range of the provided power cord.

Connect the power cord after checking that the power switch of the DX is turned
OFF.

To prevent electric shock or fire, be sure to use the power cord supplied by
YOKOGAWA.

Make sure to perform protective earth grounding to prevent electric shock.
Connect the power cord of the desktop type to a three-prong power outlet with a
protective earth terminal.

Do not use an extension cord without protective earth ground. Otherwise, the
protection function will be compromised.

Use a power supply that meets the following conditions:
Item Condition
Rated supply voltage 100 to 240 VAC
Allowable power supply voltage range 90 to 132, 180 to 264 VAC
Rated power supply frequency 50/60 Hz
Allowable power supply frequency range 50/60 Hz + 2%

Maximum power consumption

74 VA (100V) and 100 VA (240 V)

Note

Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on
the measurement accuracy.

Connection Procedure

1.

Check that the power switch is OFF.

2. Connect the power cord plug to the power connector on the rear panel. (Use the

power cord that comes with the package.)

3. Check that the power outlet meets the conditions given in the table above and

that the supply voltage is within the maximum rated voltage range of the power
cord that comes with the package. Then, connect the other end of the power cord
to the power outlet. The AC outlet must be of a three-prong type with a protective
earth ground.
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Recommended Replacement Periods for Worn Parts

Maintenance

To preserve the reliability of the DX and to use the DX in a good condition for an
extended time, it is recommended that periodic replacements be made on parts. The
replacement parts may change to accommodate preventive maintenance over extended
time. Be sure to check with your nearest YOKOGAWA dealer.

The following table shows the recommended replacement period for expendable parts.
The replacement period shown here applies when the recorder is used under standard
operating conditions. For the actual replacement period, consider the actual conditions
of use. Replacement of parts will be carried out by a YOKOGAWA engineer or an
engineer certified by YOKOGAWA. Contact your nearest YOKOGAWA dealer when such
replacement is necessary.

Item s:'g:f:ement Name Part No. S::gtlty Notes
LCD 5 years BEZEL Assembly B8706GK 1 For DX2000, Style number H: 5
without /D5, /KB1, and /KB2 options
B8706KC 1 For DX2000, Style number H: 5
with /D5 option and without /KB1 and
/KB2 options
B8706KD 1 For DX2000, Style number H: 5
without /D5 option and with /KB1 or /
KB2 options
B8706KE 1 For DX2000, Style number H: 5
with /D5 and /KB1 or /KB2 options
Battery 10 years Battery Assembly B8800ZK 1
Dust and water 5 years Packing B8706FY 1
proof strip 5 years Key Case Assembly B8706BM 1 English specifications
5 years Key Case Assembly B8706BY 1 Japanese specifications
Aluminum 5 years* Power Supply Assembly |- 1
electrolytic capacitor |5 years* AD Assembly Depends on the model

* Replacement period at the upper limit of the normal operating temperature (50°C)
The replacement period varies depending on the operating temperature and the specifications of the DX.
The lower the operating temperature, the longer is the replacement period. For example, if the operating
temperature is 30°C, it may be possible to use the parts for more than 10 years.

Note

» The LCD replacement period indicates the half life of the brightness when the brightness
is set to the factory default setting. The half life is shortened as the brightness is set
higher. The deterioration of brightness varies depending on the condition of use, and its
determination is subjective. Consider these facts for determining the actual replacement
period.

» The color of the LCD may become yellowish as time elapses. The discoloration tends to
progress faster as the brightness is set higher.

A
o
o3
g3
o
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Setup Items and Default Values

The setup items and the default values in the setting mode are listed below. Enter the
settings that you are using in the Setting column for your convenience.

Setting mode menu
=31
BATCH OVERVIEW '-}'\",,"‘ ALL BATCH @

2018/04/85 14:21:38
TR | [ fulti batch | File ] Set Calibration |

Date/Tine ® p Page 69

Heas channel ® 13 Page 69 to 71
Hath channel @ » Page 72 to 73"
Ext. channel @ b Page 74
Display @ b Page 75

Group set, Trip line @ Page 76
Hessage. Comment Text @ > Page 76

Timer. Event action @ 14 Pages 76 to 78
Data save @ 4 Page 79

Web Report @ Page 79"

Henu customize ® b Page 80

Basic setting mode e Page 80

tEnd: On models with advanced security (/AS1 option) e—— Page 80"

BATCH OVERVIEW =1
2016/84/85 14:21:51 ‘A ALL BATCH ®

Henu I tulti batch || File ] Set Calibration ]

Group set, Trip line @ Page 81"
File header, Data file name @ Page 81"
Batch text Page 81"
BATCH QVERVIEW ]
2010/04/05 14-22:42 Pl GEDRERTCH @

fenu 1 Hulti bateh ] File i Set Calibration |

Calibration correction @ Page 81"
Finish Calibration ® Page 81"
BATCH OVERVIEN ]
2016/84/85 14:02:14 ‘e GEDREATCH @

fenu |\ tulti batch | NESEATENNNN] Set Calibration |

Load display data @ Page 81
Load event data @ Page 81
Load settings @ Page 82
Save settings e Page 82
Custon display load @ » Page 82
Custon display save @ b Page 82
Load tenplate @ Page 82"
Save template @ Page 82"
File list/delete @ Page 82
Format @ Page 82
*: Options

68 IM 04L42B01-02E



Setup Items and Default Values

Basic setting mode menu

Basic Setting Mode

T | Henu ] FileZInitialize |

Operating environnent @ Page 83
View, Hessage. Inpout, Tas @ Page 83
flarn ® 13 Page 83
Remote @- Page 83‘1
Security. Hedia save, Batch @ Page 84
Comnuni cation ® 4 Page 84
Hath, Report ® Page 84"
End @ Page 84
Basic Setting Mode Eft:;
Environment | IETTTINNN || File/Initialize |
fAlarn @ Page 85
A/D, Henorye Page 85
Burnout, RICe Page 85
Keylock @ b Page 86
Login® b Pages 86 to 877
Report e > Page 88"
Tine settingse Page 88
Communication (Ethernet} @ b Page 89 to 92
Communication (Serial) ® 3 Page 93*1
Status relay b Page 94"
Set Calibration @ Page 94
Hlo Page 94
L Communication (PROFIBUS-DP): .
On models with the PROFIBUS-DP Interface (/CP1 option).e———Page 93 !

L— Signature: On models with advanced security (/AS1 option) *——Page 85"
t

Basic Setting Hode

Environnent | Henu W File/Initialize ]|

Load settingse Page 95
Initialize® Page 95
Hedia eject ® b Page 95
End @ Page 95

1: Options
2: Displayed when the function is enabled in the Environment settings.

o
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Setup Items and Default Values

This section uses the following notations in tables.

*1: This indicates functions that are available for release number 2 or later.
*2: This indicates functions that are available for release number 3 or later.
*3: This indicates functions that are available for release number 4 or later.

Menu tab?
Date/Time > Time settings
Setup Item Selectable Range or Selections Default Value Setting
Time set - 2008/01/01°2
00:00:00
Date/Time > Daylight Saving Time
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Start time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/ MAR
OCT/NOV/DEC
Start time > Day order 1st/2nd/3rd/4th/Last 2nd
Start time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Start time > Hour of the day Numerical value 2
End time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/ NOV
OCT/NOV/DEC
End time > Day order 1st/2nd/3rd/4th/Last 1st
End time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
End time > Hour of the day Numerical value 1
Meas channel > Range, Alarm
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Range > Mode Skip/Volt/TC/RTD/Scale/Delta/DI/ Volt
1-5V/Sqrt
Mode=Volt
Range 20mV/60mV/200mV/2V/6V/20V/50V 2v
Span Lower Depends on the range. -
Span Upper Depends on the range. —
Mode=TC
Range R/S/B/K/EIJIT/N/WIL/U/WRe R
Span Lower (Options may add additional settings.) —
Span Upper Depends on the range. _
Depends on the range.
Mode=RTD
Range Pt/JPt (Options may add additional settings.) Pt
Span Lower Depends on the range. —
Span Upper Depends on the range. -
Mode=Scale
Type Volt/TC/RTD/DI Volt
Range Depends on the type. -
Span Lower Depends on the range. -
Span Upper Depends on the range. —
Scale Lower —30000 to 30000, decimal position: 0 to 4 0.00
Scale Upper -30000 to 30000, decimal position: 0 to 4 200.00
Unit 6 characters or less -
Mode=Delta
Type Volt/TC/RTD/DI Volt
Range Depends on the type. -
Span Lower Depends on the range. -
Span Upper Depends on the range. —
Ref.CH Meas channel number -
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Setup Items and Default Values

Setup Item Selectable Range or Selections Default Value Setting
Mode=DI
Range Level/Cont Level
Span Lower 0,1 0
Span Upper 0,1 1
Mode=1-5V
Range 1-5V 1-5V
Span Lower 0.800 to 5.200 1.000
Span Upper 0.800 to 5.200 5.000
Scale Lower —30000 to 30000, decimal position :0 to 4 0.00
Scale Upper —30000 to 30000, decimal position :0 to 4 200.00
Unit 6 characters or less -
Low-cut On/Off Off
Mode=Sqrt
Range 20mV/60mV/200mV/2V/6V/20V/50V
Span Lower Depends on the range. -
Span Upper Depends on the range. -
Scale Lower —30000 to 30000, decimal position: 0 to 4 0.00
Scale Upper —30000 to 30000, decimal position: 0 to 4 200.00
Unit 6 characters or less -
Low-cut On/Off Off
Low-cut value 0.0t0 5.0 0.5
Alarm
1,2,3,4 On/Off Off
Type H:High/L:Low/h:delta H/l:delta L/R:rate H/ H
r:rate L/T:delayH/t:delayL
Value Numerical value -
Relay On/Off Off
Number 101/.../106, 111/.../116, 121/.../126, 101
131/.../136 (Depends on the option.)
S01/S02/S03/.../1S29/S30
Detect On/Off On
Meas channel > Tag, Memory sample, Alarm delay
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
First-CH, Last-CH Channel number 001
Tag > Comment? 32 characters or less™ -
Tag > No.” 16 characters or less -
Memory sample > On/Off On/Off On
Alarm delay > Time 1 to 3600 10
With /AS17
The First-CH, Last-CH, Tag, and Memory sample items are the same as on a DX without the /AS1 option.
Alarm delay > Time 1 to 3600 when the unit is seconds. 1 to 24 when 10
the unit is hours.
Alarm delay > Unit Hour/Sec Sec
Meas channel > Moving average
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Moving average > On/Off On/Off Off
Moving average > Count 2 to 400 2

IM 04L42B01-02E

71

o
o
)
c
—
<
O
c
o
7]

pue sw?}| dnjag




Setup Items and Default Values

Meas channel > Color

Setup Item Selectable Range or Selections Default Value Setting

Group of channel 001-010, etc Depends on the model.

Color Red/Green/Blue/B.violet/Brown/Orange/ Red to Gray
Y.green/Lightblue/Violet/Graly/Lime/Cyan/
Darkblue/Yellow/Lightgray/Purple/Black/Pink/
L.brown/L.green/Darkgray/Olive/DarkCyan/

S.green (24 colors)

Meas channel > Zone, Scale, Bar graph

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH Channel number 001

Zone > Lower 0to 95 0

Zone > Upper 5to 100 100

Scale > Position Off/1/2/3/4/5/6/7/8/9/10 1

Scale > Division 4/5/6/7/8/9/10/11/12/C10 10

Bar graph > Base position Normal/Center/Lower '/Upper’’ Normal

Bar graph > Division 4/5/6/7/8/9/10/11/12 10

Meas channel > Partial

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH Channel number 001

On/Off On/Off Off

Expand 1to 99% 50

Boundary Span Lower+1digit to Span Upper-1digit 0.0000

Meas channel > Alarm mark, Color scale band

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH Channel number 001

Alarm mark > Mark kind Alarm/Fixed Alarm

Alarm mark > Indicate on Scale On/Off Off

Alarm mark > Alarm mark color > Alarm 1 Red/Green/.../S.green (24 colors) Red

Alarm mark > Alarm mark color > Alarm 2 Same as Alarm 1 Orange

Alarm mark > Alarm mark color > Alarm 3 Same as Alarm 1 Orange

Alarm mark > Alarm mark color > Alarm 4 Same as Alarm 1 Red

Color scale band > Band area Off/In/Out Off

Color scale band > Color Auto?/Red/Green/.../S.green (24 colors) Lime

Color scale band > Display position > Lower  Measuring range 0.0000

Color scale band > Display position > Upper ~ Measuring range 0.0100

Meas channel > Calibration correction

Setup Item Selectable Range or Selections Default Value Setting

First-CH, Last-CH Channel number 001

Number of set points Off/2/3/4/516/7/8/9/10/11/12/13/14/15/16 Off

1ton > MES val
1ton > True val

Value in the measuring range/measured value
Measuring range
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Setup Items and Default Values

Math channel > Calculation expression, Alarm

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
Math range > Math On/Off On/Off Off
Math range > Calculation expression 120 characters or less -
Math range > Span Lower —9999999 to 99999999, decimal position: 0 to 4 —-200.00
Math range > Span Upper —9999999 to 99999999, decimal position: 0to 4  200.00
Math range > Unit 6 characters or less —
Math alarm
1,2,3,4 On/Off Off
Type H:High/L:Low/T:delayH/t:delayL -
Value Numerical value -
Relay On/Off On/Off Off
Number 101/.../106, 111/.../116, 121/.../126, 101
131/.../136 (Depends on the option.)
S01/S02/S03/.../S29/S30
Detect On/Off On
Math channel > Constant
Setup Item Selectable Range or Selections Default Value Setting
Number of constant K01 to K60 K01
Value —9.9999E+29 to —1.0000E-30, 0, 1
1.0000E—-30 to —9.9999E+29
Math channel > Tag, Memory sample, Alarm delay
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
Tag > Comment 2 32 characters or less —
Tag > No.” 16 characters or less -
Memory sample > On/Off On/Off On
Alarm delay > Time 1 to 3600 10
Math channel > TLOG, Rolling average
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
TLOG > Timer type™ Timer/Match T Timer
TLOG > Timer No. 1/2/3/4 1
1/2/3/.../11/12 (on models with the /BT2 multi
batch option)™
TLOG > Sum scale Off, /s, /min, /h Off
TLOG > Reset On/Off Off
Rolling average > On/Off On/Off Off
Rolling average > Interval 1s/2s/3s/4s/5s/6s/10s/12s/15s/20s/30s/ 10s

Rolling average > Number of
samples

1min/2min/3min/4min/5min/6min/10min/12min/

15min/20min/30min/1h
1 to 1500

Math channel > Color

Setup items and values are the same as those for measurement channels, except the channel numbers.

Math channel > Zone, Scale, Bar graph
Setup items and values are the same as those for measurement channels, except the channel numbers.

Math channel > Partial

Setup items and values are the same as those for measurement channels, except the channel numbers.

Math channel > Alarm mark, Color scale band
Setup items and values are the same as those for measurement channels, except the channel numbers.
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Setup Items and Default Values

Math channel > Math start action

Setup Item Selectable Range or Selections Default Value Setting
Math start action > Math start Off/Start/Rst+St Start

74 IM 04L42B01-02E



Setup Items and Default Values

Ext. channel > Range, Alarm

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 201
Ext. range > On/Off On/Off Off
Ext. range > Span Lower —30000 to 30000, decimal position: 0 to 4 —200.00
Ext. range > Span Upper —30000 to 30000, decimal position: 0 to 4 200.00
Ext. range > Unit 6 characters or less -
Ext. alarm
1,2,3,4 On/Off Off
Type H:High/L:Low/T:delayH/t:delayL -
Value Numerical value -
Relay On/Off On/Off Off
Number 101/.../106, 111/.../116, 121/.../126, 101
131/.../136 (Depends on the option.)
S01/S02/S03/.../1S29/S30
Detect On/Off On

Ext. channel > Color

Setup items and values are the same as those for measurement channels, except the channel numbers.

Ext. channel > Zone, Scale, Bar graph
Setup items and values are the same as those for measurement channels, except the channel numbers.

Ext. channel > Partial, Alarm mark, Color scale band
Setup items and values are the same as those for measurement channels, except the channel numbers.
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Setup Items and Default Values

Display > Trend (Circular)/Save interval

Setup Item

Selectable Range or Selections

Default Value Setting

Trend/Save interval

Trend interval [/div] 5s"2/10s"%/15s/30s/1min/2min/5min/10min/15min/ 1min
20min/30min/1h/2h/4h/10h (Depends on the model.)

Save interval 10min to 31day (Depends on the trend interval.) 1h

Second interval [/div] 5s"2/10s%/15s/30s/1min/2min/5min/10min/15min/ 1min
20min/30min/1h/2h/4h/10h (Depends on the model.)

Circular/Save interval

Time per revolution [/rev] 20min/30min/1h/2h/6h/8h/12h/16h/1day/ 1day
2day/1week/2week/4week

Save interval 10min to 31day (Depends on the time per revolution.) 1h

Offset time Off/1h to 23h (Depends on the time per revolution.) Off

Display > Trend (Circular), Bar graph, LCD, Monitor

Setup Item Selectable Range or Selections Default Value Setting
Trend
Trend > Direction Horizontal/Vertical/Wide/Split Horizontal
Trend > Trend clear On/Off Off
Trend > Message direction Horizontal/Vertical Horizontal
Trend > Scale > Digit Normal/Fine Normal
Trend > Scale > Value indicator Mark/Bargraph Mark
Trend > Trend line 1/2/3 2
Trend > Grid Auto/4/5/6/7/8/9/10/11/12 Auto
Circular
Circular > Full circle action Aliclear/Divclear Aliclear
Circular > Trend line 11213 2
Circular > Grid Auto/4/5/6/7/8/9/10/11/12 Auto
Bar graph > Direction Horizontal/Vertical Vertical
LCD > Brightness 1/2/3/4/5/6 2
LCD > Backlight saver > Mode Off/Dimmer/Timeoff Off
LCD > Backlight saver > Saver time 1min/2min/5min/10min/30min/1h 1h
LCD > Backlight saver > Restore Key, Key+Alarm Key+Alarm
Monitor > Background > Display White/Black White
Monitor > Background > Historical trend White/Cream/Black/Lightgray Black
Monitor > Scroll time 5s/10s/20s/30s/1min 10s
Monitor > Jump default display Off/1min/2min/5min/10min/20min/30min/1h Off

Display > Annunciator 2

Setup Item Selectable Range or Selections Default Value Setting
Annunciator position 1to 80 1

On/Off On/Off Off

Channel Channel number 001

Level 1 /2/3/4/All 1

Comment txt block No. 1to 100 1

Display > FAVORITE Key action

Setup Item Selectable Range or Selections Default Value Setting
Action History/Favorite Favorite

Group display Current/Saved Saved

Time axis zoom Current/Saved Saved
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Setup Items and Default Values

Group set, Trip line

Setup Item Selectable Range or Selections Default Value Setting
Group number 1/2/3/...135/36 1
Group set > On/Off On/Off Group 1to 4: On
Group 5 to 36: Off
Group set > Group name 16 characters or less GROUP1 etc.
Group set > CH set 39 characters or less Depends on the model.
Trip line > 1 On/Off Off
Trip line > 2 On/Off Off
Trip line > 3 On/Off Off
Trip line > 4 On/Off Off
Trip line > Position 0to 100 50
Trip line > Color Red/Green/.../S.green (24 colors) 1:Red, 2:Green
3:Blue, 4:Yellow

Trip line > Line width 1/2/3 2
Message, Comment Text 2 > Message
Setup Item Selectable Range or Selections Default Value Setting
Message No. 1-10/11-20/21-30/31-40/41-50/51-60/ 11-20"3

61-70/71-80/81-90/91-100
1to 100 32 characters or less —
Message, Comment Text > Comment text fields 2
Setup Item Selectable Range or Selections Default Value Setting
Coment txt field no 1 to 200 1
Text info 32 characters or less —
Message, Comment Text > Comment text block?
Setup Item Selectable Range or Selections Default Value Setting
Coment txt block no 1to 100 1
Line > 1 > Comment txt field no 1 to 200 1
Line > 2 > Comment txt field no 1 to 200 1
Line > 3 > Comment txt field no 1 to 200 1
Line > 4 > Comment txt field no 1 to 200 1
Line > 5> Comment txt field no 1 to 200 1
Timer, Event action > Timer
Setup Item Selectable Range or Selections Default Value Setting
Timer No. 1/2/3/4 1

1/2/3/.../11/12 (on models with the /BT2 multi

batch option)
Mode Off/Relative/Absolute Off
Relative > Interval 00:01 to 24:00 01:00
Relative > Reset at Math Start On/Off On
Absolute > Interval 1min/2min/3min/4min/5min/6min/10min/ 1h

12min/15min/20min/30min/1h/2h/3h/4h/

6h/8h/12h/24h
Absolute > Ref.time 0to 23 0:00
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Setup Items and Default Values

Timer, Event action > Match time timer

Setup Item Selectable Range or Selections Default Value Setting
Timer number 1/2/3/4 1
1/2/3/.../11/12 (on models with the /BT2 multi
batch option)
Kind Off/Day/Week/Month Off
Day 1 to 31 (varies depending on the month) 1
Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Hour 00:00 to 23:59 00:00
Timer action Single/Repeat Repeat
Timer, Event action > Event action
Setup Item Selectable Range or Selections Default Value Setting
Logic box number 1/2/3/...139/40 1
Event None/Remote/Relay/Switch/Timer/ None
Matchtime/Alarm/UserKey/
EventLevelSwitch™?/EventEdgeSwitch %/
Relay-Off %/Switch-Off 3/Alarm-Off 3/
EventlLevelSwitch-Off
Remote > Remote number 1/2/3/4/5/617/8 1
Relay > Relay number 101/.../106, 111/.../116, 121/.../126, 131/.../136, 101
(Depends on the option.)
101/.../106, 111/.../116, 121/.../126, 131/.../136,
(Depends on the option.)
Switch > Switch No. S01/S02/S03/.../S29/S30 S01
Timer > Timer No. 1/2/3/4 1
1/2/3/.../11/12 (on models with the /BT2 multi
batch option)
MatchTimeTimer > Match Time Timer No.  1/2/3/4 1
1/2/3/.../11/12 (on models with the /BT2 multi
batch option)™?
EventLevelSwitch > Event Switch No™ 1/2/3/...129/30 1
EventEdgeSwitch > Event Switch No™ 1/2/3/...129/30 1
Relay-Off > Relay number™ 101/.../106, 111/.../116, 121/.../126, 131/.../136 101
(Depends on the option.)
Switch-Off > Switch No.”™ $01/S02/S03/.../S29/S30 S01

EventLevelSwitch-Off > Event Switch No™

1/2/3/...130
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Setup Items and Default Values

Message > Select

> Batch Group No

> Display Group No
Message > All

> Batch Group No
DisplayGroupChange
> Batch Group No
DisplayGroupChange
> Display Group No

1/2/3/...111/12 (varies depending on settings)
1/2/3/...111/12

1/2/3/...111/12 (varies depending on settings)
1/2/3/.../11/12 (varies depending on settings)

1/2/3/...111/12

Setup Item Selectable Range or Selections Default Value Setting
Action MemoryStart/Stop, MemoryStart, MemoryStop,  Group
Trigger (not selectable on a DX with the /AS1
option’®), AlarmACK, AlarmDisplayReset?,
MathStart/Stop, MathStart, MathStop,
MathReset, SaveDisplay, SaveEvent, Message,
Snapshot, DisplayRate1/2, ManualSample,
TimerReset, DisplayGroupChange,
FavoriteDisplay 2, CommentDisplay?, Flag,
PanellLoad (not selectable on a DX with the /AS1
option™), TimeAdjust (Depends on the events,
etc)

Message > Message No. 1to 100 1
Message > Write to All/Select All
Message > Group number 1/2/3/...135/36 1
Group > Group number 1/2/3/...135/36 1
FavoriteDisplay > Action Key/Select Key
FavoriteDisplay > Select
> Favorite Screen No™ 1/2/3/4/5/6/7/8 1
CommentDisplay
> Comment Txt Block No™ 1to 100 1
Flag > Flag number 1/2/3/14/516/7/8 1
TimerReset > Timer No. 1/2/3/4 1

1/2/3/.../11/12 (on models with the /BT2 multi

batch option)™
PanelLoad > Setting file number 1/2/3 1
The following menus appear when the multi batch function is in use.
MemoryStart/Stop > Target Action All/Select All
MemoryStart/Stop > Select
> Batch Group No 1/2/3/...111/12 (varies depending on settings) 1
MemoryStart > Target Action All/Select All
MemoryStart > Select
> Batch Group No 1/2/3/...111/12 (varies depending on settings) 1
MemoryStop > Target Action All/Select All
MemoryStop > Select
> Batch Group No 1/2/3/.../11/12 (varies depending on settings) 1
SaveDisplay > Target Action All/Select All
SaveDisplay > Select
> Batch Group No 1/2/3/...111/12 (varies depending on settings) 1
SaveEvent > Target Action All/Select All
SaveEvent > Select
> Batch Group No 1/2/3/...111/12 (varies depending on settings) 1
MathReset > Target Action All/Select All
MathReset > Select
> Batch Group No 1/2/3/...111/12 (varies depending on settings) 1
Message > Message No. 1to 100 1
Message > Write to All/Select All
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Setup Items and Default Values

Data save > File header, Data file name

Setup Item Selectable Range or Selections Default Value Setting
File header > Characters 50 characters or less -
Data file name > Structure Date/Serial/Batch Date
Data file name > Identified strings 16 characters or less —
Data save > Save directory
Setup Item Selectable Range or Selections Default Value Setting
Directory name 20 characters or less DATAOQ
Data save > Event data
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Sample rate 25ms/125ms/250ms/500ms/1s/2s/5s/10s/30s/ 1s
60s/120s/300s/600s/15min %/20min2/30min 2
(Depends on the model.)
Mode Free/Single/Repeat Free
Data length 10min to 31day (Depends on the sample rate.) 1h
Pre-trigger 0/5/25/50/75/95/100 0
Trigger signal > Key On/Off On
With /AS17
The Sample rate and Data length items are the same as on a DX without the /AS1 option.
Mode Fixed at Free Free
There are no Pre-trigger or Trigger signal > Key items.
Data save > Manual sample
Setup Item Selectable Range or Selections Default Value Setting
Manual sample number 001 to 120 001
On/Off On/Off On
Channel Channel number 001
Data save > Batch text
Setup Item Selectable Range or Selections Default Value Setting
Text field number 110242 1
Text field > Title of field 20 characters or less -
Text field > Characters 30 characters or less -
Web Report”
Setup Item Selectable Range or Selections Default Value Setting
Web Report No 1/2/3/4/5/6/7/8/9/10 1
On/Off On/Off Off
Title 64 characters or less —
ltem > 1to 10 On/Off Off
Item > 1 to 10 > Report CH R01/R02/.../R60 RO1
ltem > 1 to 10 > Value Max/Min/Ave/Sum/Inst Sum

Item > 1 to 10 > Name

16 characters or less
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Setup Items and Default Values

Menu customize

Setup Item Selectable Range or Selections Default Value Setting
Function menu Select/Hide/View/Transfer —
Display menu Separate/Select/Hide/View/Transfer -

End (/AS1 option)™
Setup Item Selectable Range or Selections Default Value Setting
End Yes/No -

Basic setting mode™
Setup Item Selectable Range or Selections Default Value Setting
Entering basic setting mode. ... Yes/No —
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Setup Items and Default Values

Multi batch tab™
Group set, Trip line > Group set

Setup Item Selectable Range or Selections Default Value Setting
First Batch Group No, Last Batch Group No.  1/2/3/4/5/6/7/8/9/10/11/12 (varies 1
depending on settings)

Display Group No 1/2/3/4/5/6/7/8/9/10/11/12 1
Set Display Group > On/Off On/Off Off
Set Display Group > Group name 16 characters or less BATCH-1, etc.
Set Display Group > CH set 39 characters or less Depends on the model.
Trip line

1,2,3,4 On/Off Off

Position 0to 100 50

Color Red/Green/.../S.green (24 colors) 1:Red, 2:Green

3:Blue, 4:Yellow

Line Width 1/2/3 2
File header, File name™
Setup Item Selectable Range or Selections Default Value Setting
First Batch Group No, Last Batch Group No. 1/2/3/.../11/12 (varies depending on settings) 1
File header > Characters 50 characters or less —
Data file name > Structure Date/Serial/Batch Date
Data file name > Identified strings 16 characters or less -
Data save > Batch text 2
Setup Item Selectable Range or Selections Default Value Setting
First Batch Group No, Last Batch Group No. 1/2/3/.../11/12 (varies depending on settings) 1
Text field number 1to 24 1
Text field > Title of field 20 characters or less -
Text field > Characters 30 characters or less -
End (/AS1 option)™
Setup Item Selectable Range or Selections Default Value Setting
End Yes/No —

- - *
Set Calibration Tab™
Setup Item Selectable Range or Selections Default Value Setting
Calibration correction Same as Meas channel > Calibration correction
Finish Calibration > Next calibration due Year, month, and date -
Finish Calibration > Execute - -
End (/AS1 option)™
Setup Item Selectable Range or Selections Default Value Setting
End Yes/No —
. *
File tab™

Load display data
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
Load event data
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
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Setup Items and Default Values

Load settings

Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
Save settings
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
File name 32 characters or less —
Custom display load > Select?
Setup Item Selectable Range or Selections Default Value Setting
Display No. Internal 1 to Internal 3, External 1 to External 25 Internal 1
File selection screen — -
Custom display load > All*2
Setup Item Selectable Range or Selections Default Value Setting
Directory selection screen - —
Custom display save > Select 2
Setup Item Selectable Range or Selections Default Value Setting
Display No. Internal 1 to Internal 3, External 1 to External 25  Internal 1
File name 32 characters or less -
Custom display save > All"2
Setup Item Selectable Range or Selections Default Value Setting
Directory name 20 characters or less -
File list/delete (Delete is not available on DXs with the /AS1 option.™)
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
Load template™
Setup Item Selectable Range or Selections Default Value Setting
Report Kind Hour, Day, Week, Month, Hour+Day, Day+Week, -
Day+Month
Save template™
Setup Item Selectable Range or Selections Default Value Setting
Report Kind Hour, Day, Week, Month, Hour+Day, Day+Week, -
Day+Month
Template data save > File name 32 characters or less —
Format (Without /AS1)
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
Format > Volume name 11 characters or less —
End (/AS1 option)™
Setup Item Selectable Range or Selections Default Value Setting
End Yes/No -
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Setup Items and Default Values

This section uses the following notations in tables.

*1: This indicates functions that are available for release number 2 or later.
*2: This indicates functions that are available for release number 3 or later.
*3: This indicates functions that are available for release number 4 or later.

Environment tab™
Operating environment

Setup Item Selectable Range or Selections Default Value Setting
Tag/Channel Tag/Channel Tag

Language English/Japanese/German/French/Chinese English

Remote Controller ID Off/0/1/.../130/31 Off

Temperature CIF C

Decimal Point Type™ Point/Comma Point

Basic setting mode Menu display On/Off On

View, Message, Input, Tag™

Setup Item Selectable Range or Selections Default Value Setting
View > Trend type T-Y/Circular T-Y

View > Partial On/Off Off

View > Trend rate switching On/Off Off

Message > Write group Common/Separate Common

Message > Power-fail message On/Off Off

Message > Change message On/Off Off

Input > Value on over-range Free/Over Over

Tag Basic settings > Tag No. Use/Not 2 Use/Not Not

Alarm > Action™

Setup Item Selectable Range or Selections Default Value Setting
No logging On/Off Off

Annunciator mode? On/Off Off

Sequence? ISA-A-4/ISA-A/ISA-M ISA-A

Time off color? White/Green Green

Alarm > Level/Color ™2

Setup Item Selectable Range or Selections Default Value Setting
Level 1-2-3-4/1-4-2-3/1-4-3-2 1-2-3-4

Color > 1 Red/Yellow/Orange/Pink Red

Color > 2 Red/Yellow/Orange/Pink Red

Color>3 Red/Yellow/Orange/Pink Red

Color > 4 Red/Yellow/Orange/Pink Red

Remote?

Setup Item Selectable Range or Selections Default Value Setting
Level 1-2-3-4/1-4-2-3/1-4-3-2 1-2-3-4

Remote Input > 1 N.O/N.C N.O

Remote Input > 2 N.O/N.C N.O

Remote Input > 3 N.O/N.C N.O

Remote Input > 4 N.O/N.C N.O

Remote Input > 5 N.O/N.C N.O

Remote Input > 6 N.O/N.C N.O

Remote Input > 7 N.O/N.C N.O

Remote Input > 8 N.O/N.C N.O
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Setup Items and Default Values

Security, Media save, Batch

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

Security > Key Off/Login/Keylock Off

Security > Communication Off/Login Off

Save > Auto save On/Off On

Save > Media FIFO"' On/Off Off

Batch > On/Off On/Off/MultiBatch™ Off (With /AS1, On)

Batch > Lot-No. digit Off/4/6/8 6

Batch > Auto increment On/Off On

Batch operation qty ™ 2/3/4/5/6/7/8/9/10/11/12 4

With /AS17

Security > Key Login Login

Security > Communication Off/Login Off

Security > Multi login On/Off Off

Security > Password management On/Off Off

The Save items are the same as on a DX without the /AS1 option.

The Batch items are the same as on a DX without the /AS1 option.

Communication > Service port

Setup Item Selectable Range or Selections Default Value Setting
FTP 1 to 65535 21

HTTP 1 to 65535 80

SNTP 1 to 65535 123

Modbus 1 to 65535 502

Communication > POP3 Details ™

Setup Item Selectable Range or Selections Default Value Setting
POP Before SMTP > Send delay [second] 0/1/2/3/4/5/6/7/8/9/10 2

POP3 Login PLANE/APOP PLAIN

Communication > FTP Server Details?

Setup Item Selectable Range or Selections Default Value Setting
Output Directory Format MS-DOS/UNIX MS-DOS

Math, Report

Setup Item Selectable Range or Selections Default Value Setting
Math > Value on Error +Over/-Over +Over

Math > Value on Overflow > SUM, AVE Error/Skip/Limit Skip

Math > Value on Overflow > MAX, MIN, P-P QOver/Skip Over

Report > Report select > 1 Max/Min/Ave/Sum/Inst Ave

Report > Report select > 2 Off/Max/Min/Ave/Sum/Inst Max

Report > Report select > 3 Off/Max/Min/Ave/Sum/Inst Min

Report > Report select > 4 Off/Max/Min/Ave/Sum/Inst Sum

Report > File type Separate/Combine/Separate2™ Separate

Report > Use Template™ Use/Not Not

End

Setup Item Selectable Range or Selections Default Value Setting

Do you want to store and
make the new settings take effect?

Yes/No/Cancel
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Setup Items and Default Values

Menu tab™
Alarm
Setup Item Selectable Range or Selections Default Value Setting
Basic setting

Reflash On/Off/On-1s"3/0On-2s™ Off

Rate of change > Decrease 1to 32 1

Rate of change > Increase 1to 32 1

Indicator Hold/Nonhold Nonhold
Switch, Relay

Internal Switch > AND None/S01/S01-S02/.../S01-S29/S01-S30 None

Relay > AND None/I01/101-102/.../101-135/101-136 None

Relay > Action Energize/De_energ Energize

Relay > Hold Hold/Nonehold Nonhold
Relay > Relay Action on ACK"" Normal/Reset Normal
Hysteresis

Meas CH > High/Low 0.0t0 5.0 0.5

Meas CH > Delta High/Low 0.0t0 5.0 0.0

Math CH > High/Low 0.0t0 5.0 0.0

Ext. CH > High/Low 0.0t0 5.0 0.0
A/D, Memory
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Scan interval > Scan mode Normal/Fast Normal

Normal > Scan interval 125ms/250ms(DX2004, DX2008) 125ms

1s/2s/5s(DX2010, DX2020, DX2030, DX2040, 1s
DX2048)
Normal > A/D integrate Auto/50Hz/60HZz/100ms Auto
Fast T> Scan interval 25ms (DX2004, DX2008) 25ms
125ms (DX2010, DX2020, DX2030, DX2040, 125ms
DX2048)

Fast ™> A/D integrate 600Hz 600Hz
Memory > Data kind Display/E+D/Event Display
With /AS173
The Scan interval items are the same as on a DX without the /AS1 option.

Memory > Data kind Display/Event Display

1: You cannot select this option on a DX with external input channels (/MC1) or when the multi batch function (/BT2) is in use.

Signature (/AS1 option)™

Setup Item Selectable Range or Selections Default Value Setting
Process type Batch/Continue Batch

Sign from recorder Off/Sign1/Sign1+2/Sign1+2+3 Off

Signature at batch stop On/Off Off

FTP transfer at signing On/Off Off

Burnout, RJC

Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001

Burnout set > Mode Off/Up/Down Off

RJC > Mode Internal/External Internal

RJC > Volt —20000 to 20000uV 0
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Setup Items and Default Values

Keylock (Without /AS1)

Setup Item Selectable Range or Selections Default Value Setting

Password 8 characters or less -

Key action > START Free/Lock Free

Key action > STOP Free/Lock Free

Key action > MENU Free/Lock Free

Key action > USER Free/Lock Free

Key action > DISP/ENTER Free/Lock Free

Key action > FAVORITE Free/Lock Free

Media/USB > External media Free/Lock Free

Media/USB > Load settings Free/Lock Free

Action of Function > AlarmACK Free/Lock Free

Action of Function > Message/Batch Free/Lock Free

Action of Function > Math Free/Lock Free

Action of Function > Data save Free/Lock Free

Action of Function > E-mail/FTP Free/Lock Free

Action of Function > Time set Free/Lock Free

Action of Function > Display Function Free/Lock Free

Login > Basic settings

Setup Item Selectable Range or Selections Default Value Setting

Without /AS1

Auto logout Off/1min/2min/5min/10min Off

Operation without Login Off/Display Off

With /AS17

Auto logout Off/1min/2min/5min/10min Off

Operation without Login Off/Display Off

User ID Use/Not Use

Password retry frequency 3/5/0ff 3

Root password > Password 20 characters or less 2??2°°?7°7?

Login > Admin settings

Setup Item Selectable Range or Selections Default Value Setting

Without /AS1

Admin number 1t05 1

Mode Off/Key/Web/Key+Comm Off

User name 20 characters or less Admin1 etc.

Password 20" characters or less 22277227

With /AS17

Admin number 1t05 1

Mode Off/Key/Web/Key+Comm Off

User name 20 characters or less Admin1 etc.

User ID 8 characters or less -

Password 20 characters or less Yeaadaads

Password expire Off/1month/3month/6month Off
o8
~ 0
5 3
=
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Setup Items and Default Values

Login > User settings

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

User number 1to 30 1

Mode Off/Key/Comm/Web/Key+Comm Off

User name 20 characters or less User1 etc.
Password 20°3 characters or less 27?22?77
Authority of user Off/1/2/3/4/5/6/7/8/9/10 Off

With /AS17

User number 1to 90 1

Mode Off/Key/Comm/Web/Key+Comm Off

User name 20 characters or less User1 etc.
User ID 8 characters or less -
Password 20 characters or less Yeaadaads
Password expire Off/1month/3month/6month Off
Authority of user Off/1/2/3/4/5/6/7/8/9/10 Off
Login > Authority of user > Key action, Media

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

Authority of user 1/2/3/4/5/6/7/8/9/10 1

Key action > START Free/Lock Free

Key action > STOP Free/Lock Free

Key action > MENU Free/Lock Free

Key action > USER Free/Lock Free

Key action > DISP/ENTER Free/Lock Free

Key action > FAVORITE Free/Lock Free
Media/USB > External media Free/Lock Free
Media/USB > Load settings? Free/Lock Free
Authority of user 1/2/3/4/5/6/7/8/9/10 1

Action of Function > AlarmACK Free/Lock Free
Action of Function > Message/Batch Free/Lock Free
Action of Function > Math Free/Lock Free
Action of Function > Data save Free/Lock Free
Action of Function > E-mail/FTP Free/Lock Free
Action of Function > Time set Free/Lock Free
Action of Function > Display Function Free/Lock Free

With /AS17

The Authority of user, Key action, and Media/USB items are the same as on a DX without the /AS1 option.

Actions > AlarmACK Free/Lock Free
Actions > Message/Batch Free/Lock Free
Actions > Math Free/Lock Free
Actions > Data save Free/Lock Free
Actions > E-mail/FTP Free/Lock Free
Actions > Time set Free/Lock Free
Actions > Display Function Free/Lock Free
Action > Calibration Free/Lock Free
Sign record > Signature1 Free/Lock Free
Sign record > Signature2 Free/Lock Free
Sign record > Signature3 Free/Lock Free
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Setup Items and Default Values

Report > Basic settings

Setup Item Selectable Range or Selections Default Value Setting
Report kind Off/Hour/Day/Hour+Day/Day+Week/Day+Month Off

Date 1to 28 1

Day of the week (Day+week) SUN/MON/TUE/WED/THU/FRI/SAT SUN

Time (hour) 0to 23 0:00

Report > Report settings

Setup Item Selectable Range or Selections Default Value Setting
Report channel number R01/R02/R03/.../R59R60 RO1

On/Off On/Off Depends on the model

Channel Channel number 001 etc.

Sum scale Off, /s, /min, /h, /day /s

Time settings

Setup Item Selectable Range or Selections Default Value Setting
Time zone (HHMM) —1300 to 1300 900

Time deviation limit Off/10s/20s/30s/1min/2min/3min/4min/5min 30s

Date format Y/M/D, M/D/Y, DIM/Y, D.M.Y Y/M/D

Calender display > 1st weekday? SUN/MON MON
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Setup Items and Default Values

Communication (Ethernet) > IP-address, Host settings

Setup Item Selectable Range or Selections Default Value Setting
DHCP Use/Not Not
DNS accession Use/Not Use
Host-name register Use/Not Use
Fixed IP-address > |IP-address 0.0.0.0 to 255.255.255.255 0.0.0.0
Fixed IP-address > Subnet mask 0.0.0.0 to 255.255.255.255 0.0.0.0
Fixed IP-address > Default gateway 0.0.0.0 to 255.255.255.255 0.0.0.0
Host settings > Host name 64 characters or less —
Host settings > Domain name 64 characters or less —
Communication (Ethernet) > DNS settings
Setup Item Selectable Range or Selections Default Value Setting
Server search order > Primary 0.0.0.0 to 255.255.255.255 0.0.0.0
Server search order > Secondary 0.0.0.0 to 255.255.255.255 0.0.0.0
Domain suffix search order > Primary 64 characters or less -
Domain suffix search order > Secondary 64 characters or less —
Communication (Ethernet) > Keep alive, Application time out
Setup Item Selectable Range or Selections Default Value Setting
Keep alive On/Off On
Application time out > On/Off On/Off Off
Application time out > Time 1 to 120 (min) 1
Communication(Ethernet) > Server > Server modes
Setup Item Selectable Range or Selections Default Value Setting
FTP Use/Not Use™
Web Use/Not Use
SNTP Use/Not Not
Modbus Use/Not Not
PLC communication protocol Use/Not Not
Communication(Ethernet) > Server > Allowed Modbus clients
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Client number 1/2/3/4/5/6/7/8/9/10 1
On/Off On/Off Off
Communication (Ethernet) > Web page
Setup Item Selectable Range or Selections Default Value Setting
Without /AS1
Page type Operator/Monitor Operator
Page type=Operator
Web page > On/Off On/Off Off
Web page > Access control Off/Admin Off
Web page > Command Use/Not Not
Page type=Monitor
Web page > On/Off On/Off Off
Web page > Access control Off/Admin/User Off
With /AS173
Page type Operator/Monitor Operator
Page type=Operator
Web page > On/Off On/Off Off
Web page > Access control Off/Admin Off

The items when Page type is set to Monitor are the same as on a DX without the /AS1 option.
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Setup Items and Default Values

Communication (Ethernet) > E-Mail > Basic settings

Setup Item Selectable Range or Selections Default Value Setting
SMTP server name 64 characters or less -

Port number 0 to 65535 25

Security? Off/PbS™?/Auth™ Off

SMTP authorization > User name 32 characters or less -

(when Auth is selected)™

SMTP authorization > Password 32 characters or less -

(when Auth is selected)®

Communication (Ethernet) > E-Mail > Recipients

Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 150 characters or less -

Recipient 2 150 characters or less -

Sender 64 characters or less —

Communication (Ethernet) > E-Mail > POP3 settings 2

Setup Item Selectable Range or Selections Default Value Setting
POP3 Server name 64 characters or less —

Port number 0 to 65535 110

Login name 32 characters or less -

Password 32 characters or less ok
Communication (Ethernet) > E-Mail > Alarm settings

Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 On/Off Off

Recipient 2 On/Off Off

Active Alarms > Alarm 1 On/Off Off

Active Alarms > Alarm 2 On/Off Off

Active Alarms > Alarm 3 On/Off Off

Active Alarms > Alarm 4 On/Off Off

Include INST On/Off Off

Include source URL On/Off Off

Subject 32 characters or less Alarm_summary

Header 1 64 characters or less -

Header 2 64 characters or less —

Send alarm action? On+0ff/On On+Off

Include tag/ch in Subject On/Off Off

Communication (Ethernet) > E-Mail > Scheduled settings

Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 On/Off Off

Interval 1h/2h/3h/4h/6h/8h/12h/24h 24h

Ref.time 00:00 to 23:59 00:00

Recipient 2 On/Off Off

Interval 1h/2h/3h/4h/6h/8h/12h/24h 24h

Ref.time 00:00 to 23:59 00:00

Include INST On/Off Off

Include source URL On/Off Off

Subject 32 characters or less Periodic_data

Header 1 64 characters or less -

Header 2 64 characters or less —
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Setup Items and Default Values

Communication (Ethernet) > E-Mail > System settings

Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 On/Off Off

Recipient 2 On/Off Off

Include source URL On/Off Off

Subject 32 characters or less System_warning

Header 1 64 characters or less -

Header 2 64 characters or less —

Communication (Ethernet) > E-Mail > Report settings

Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 On/Off Off

Recipient 2 On/Off Off

Include source URL On/Off Off

Subject 32 characters or less Report_data

Header 1 64 characters or less -

Header 2 64 characters or less -

Communication (Ethernet) > FTP client > FTP transfer file

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

FTP transfer file > Disp&Event data On/Off Off

FTP transfer file > Report On/Off Off

FTP transfer file > Snapshot On/Off Off

Transfer wait time > Disp&Event data™ 0 to 120 min 0

Transfer wait time > Report™? 0 to 120 min 0

With /AS17

FTP transfer file > Disp&Event data On/Off Off

FTP transfer file > Report On/Off Off

FTP transfer file > Snapshot On/Off Off

FTP transfer file > Setting On/Off Off

The Transfer wait time items are the same as on a DX without the /AS1 option.

Communication (Ethernet) > FTP client > FTP connection

Setup Item Selectable Range or Selections Default Value Setting
FTP connection Primary/Secondary Primary

FTP server name 64 characters or less —

Port number 0 to 65535 21

Login name 32 characters or less —

Password 32 characters or less i

Account 32 characters or less -

PASV mode On/Off Off

Initial path 64 characters or less —

Communication (Ethernet) > SNTP client

Setup Item Selectable Range or Selections Default Value Setting

SNTP client > Use/Not

Use/Not

Not

SNTP client > Server name

64 characters or less

SNTP client > Port number 0 to 65535 123
SNTP client > Access interval Off/1h/8h/12h/24h 8h
SNTP client > Access reference time 00:00 to 23:59 00:00
SNTP client > Access timeout 10s/30s/90s 30s
SNTP client > Time adjust on Start action ~ On/Off Off
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Setup Items and Default Values

Communication (Ethernet) > Modbus client > Basic settings

Setup Item Selectable Range or Selections Default Value Setting
Basic settings > Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s
Basic settings > Retry interval Off/10s/20s/30s/1min/2min/5min/10min/ 2min
20min/30min/1h
Communication (Ethernet) > Modbus client > Modbus server settings
Setup Item Selectable Range or Selections Default Value Setting
Server number 1-8/9-16 1-8
Port 0 to 65535 502
Modbus server name 64 characters or less -
Unit Auto/Fixed Auto
No. 0 to 255 1
Communication (Ethernet) > Modbus client > Command settings
Setup Item Selectable Range or Selections Default Value Setting
Client command number 1-8/9-16 1-8
1t0 16 Off/RIR-M/W/W-M/E-M® Off
First Depends on the command type. -
Last Depends on the command type. —
Server 1/2/3/.../15/16 1
Regi. Numerical value 30001
Type INT16/UINT16/INT32_B/INT32_L/UINT32_B/ INT16

UINT32_L/FLOAT_B/FLOAT_L

Communication (Ethernet) > Modbus client > Auto settings
Automatically assigns MW100s to the DX.

Communication (Ethernet) > Password management > KDC connection (/AS1 option)™

Setup Item

Selectable Range or Selections

Default Value

Setting

KDC connection
KDC server name

Port number

Primary/Secondary
64 characters or less
0 to 65535

Primary

88

Communication (Ethernet) > Password management > Certification key (/AS1 option)™

Setup Item Selectable Range or Selections Default Value Setting
Host principal 20 characters or less -

Realm name 64 characters or less —

Password 20 characters or less —

Encryption AES128/AES256/ARC4 AES128
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Setup Items and Default Values

Communication (Serial) > Basic settings

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

Baud rate 1200/2400/4800/9600/19200/38400 9600

Data length 8

Parity Odd/Even/None Even

Handshaking Off:Off XON:XON/XON:RS/CS:RS Off:Off

Address 1

Protocol Normal/Modbus/Modbus-M Normal

With /AS13

The baud rate, data length, parity, handshaking, address items are the same as on a DX without the /AS1 option.

Protocol

Normal/Modbus/Modbus-M/Barcode

Normal

Communication (Serial) > Modbus master > Basic settings

Setup Item Selectable Range or Selections Default Value Setting

Read cycle 125ms/250ms/500ms/1s/2s/5s/10s 1s

Timeout 125ms/250ms/500ms/1s/2s/5s/10s/1min 1s

Retrials Off/1/2/3/4/5/10/20 1

Inter-block delay Off/5ms/10ms/15ms/45ms/100ms Off

Auto recovery Off/1min/2min/5min/10min/20min/30min/1h 2min

Communication (Serial) > Modbus master > Command settings

Setup Item Selectable Range or Selections Default Value Setting

Master command number 1-8

1to0 16 Off/R/R-M/W/W-M/E-M Off

First Depends on the command type. -

Last Depends on the command type. -

Addr. 1

Regi. Numerical value 30001

Type INT16/UINT16/INT32_B/INT32_L/UINT32_B/ INT16
UINT32_L/FLOAT_B/FLOAT L

Communication (PROFIBUS-DP)?

Setup Item Selectable Range or Selections Default Value Setting

Node Address 3
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Setup Items and Default Values

Status relay™

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

Fail relay Fail/Status relay Fail

Status relay Fail/Status relay Status relay

With /AS1

Fail relay Fail/Status relay/Mem. sample/Invalid user/Login  Fail

Status relay Fail/Status relay/Mem. sample/Invalid user/Login  Status relay

Status Relay > Status Relay Details™

Setup Item Selectable Range or Selections Default Value Setting
Memory/Media status On/Off Off

Measurement error On/Off Off

Communication error On/Off Off

Memory stop On/Off Off

Alarm™? On/Off Off

Set Calibration™

Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not

Notification 1t0 10 1

Renotification 10min/30min/1h/8h/24h 1h

End

Setup Item Selectable Range or Selections Setting

Do you want to store and
make the new settings take effect?

Yes/No/Cancel

Default Value
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Setup Items and Default Values

File/Initialize tab
Load settings

Setup Item Selectable Range or Selections Default Value Setting
Without /AS1

Load settings > Kind CF/USB CF

Initialize > Kind Clear 1/Clear 2/Clear 3 Clear 3

Media eject CF/USB -

With /AS173

Load settings > All settings > Kind CF/USB CF

Load settings > Login info only > Kind CF/USB CF

Load settings > Other settings > Kind CF/USB CF

Initialize > Kind Clear 1/Clear 2/Clear 3/Clear 4 Clear 3

Media eject CF/USB -

End

Setup Item Selectable Range or Selections Default Value Setting

Do you want to store and
make the new settings take effect?

Yes/No/Cancel
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